[UTORIAL GRUB

RUB saat ini digunakan sebagai boot loader default pada berbagai distribusi Linux

populer. Selain berfungsi sebagai bootloader, GRUB memiliki beberapa pengaturan

lain yang bermanfaat untuk menjadikan proses boot kita lebih menarik, aman, dan

fleksibel. Kita akan membahas beberapa di antaranya.

Pertama-tama, kita akan membahas file kon-
figurasi GRUB secara sekilas, untuk melihat
opsi penting yang mungkin berguna. Setelah
itu, kita akan melihat apa yang harus kita
lakukan apabila file konfigurasi GRUB hilang
ataupun mengalami masalah. Berikutnya, kita
akan melihat bagaimana mengedit command
line kernel pada saat menu GRUB ditampil-
kan. Dan, yang terakhir, kita akan melihat tool
grubonce, yang sangat berguna.

Tulisan ini dibangun di atas sistem open-
SUSE 10.2, namun seharusnya dapat di-
terapkan tanpa masalah pada sistem lainnya.

Menu.Ist

Secara umum, file konfigurasi menu GRUB—
secara default tersimpan di /boot/grub/menu.
Ist—relatif sederhana dan dapat dimengerti
dengan mudah. File konfigurasi itu bisa dibagi
dalam dua seksi (tidak kaku, diberikan hanya
untuk memudahkan pembahasan):

® Umum.

® Per menu entry.

Berikut ini contoh konfigurasi di kom-
puter penulis:
default @
timeout 3
color Tight-blue/black blue/Tight-
gray

title  openSUSE 10.2 (hdal)
root (hd@,0)
kernel /boot/vmlinuz-

2.6.18.2-34-default root=/dev/hdal

vga=@x317 maxcpus=§ resume=/

dev/hda5 splash=verbose showopts
initrd /boot/initrd-

2.6.18.2-34-default

kecuali diinterupsi oleh pengguna.

® Baris ketiga menyatakan warna yang
akan digunakan. Berikut ini prototype
perintah:
color normal [highlight]

title  openSUSE 10.2 (hda7)
kernel (hd@,6)/boot/vm-
1inuz-2.6.18.2-34-default root=/
dev/hda7 vga=0x317 maxcpus=0
resume=/dev/hda5 splash=silent
showopts

initrd (hd@,6)/boot/ini-
trd-2.6.18.2-34-default

title Debian GNU/Linux 3.1
(hda6)

root (hd@,5)

kernel /boot/vmlinuz-

2.6.17.9-nop-20060825-1 root=/dev/

hda6 ro vga=791 suspend2=/dev/hdab
initrd /boot/initrd.img-

2.6.17.9-nop-20060825-1

title Windows
rootnoverify (hd@,0)

chainloader (hd@,1)+1

Bisa kita lihat, tiga baris pertama meru-
pakan konfigurasi seksi umum, yang akan
mempengaruhi menu GRUB secara umum.
Berikut ini adalah penjelasannya:
® Default menyatakan entri default yang

akan di boot. Entri dimulai dari 0.
® Timeout menyatakan waktu tunggu sebe-

lum melakukan booting ke nilai default,

Untuk normal dan [highlight] sendiri,
warna diberikan dalam pasangan FORE-
GROUND/BACKGROUND.

Warna yang tersedia untuk BACK-
GROUND adalah black, blue, green, cyan, red,
magenta , brown, light-gray.

Semantara, untuk warna FORE-
GROUND, warna BACKGROUND bisa di-
pergunakan, ditambah dengan  dark-gray,
light-blue, light-green, light-cyan, light-red,
light-magenta, yellow, white.

Sebagai catatan, color sendiri merupakan
perintah general, yang mana artinya bisa
diberikan pada seksi umum ataupun per
menu entry. Sekali lagi, pengelompokan
yang dilakukan ditulisan ini semata untuk
memudahkan pembahasan.

password

Selain tiga perintah tersebut, ada baiknya
kita menambahkan perintah password, yang
akan mencegah pengguna untuk mengedit
entry menu apabila password yang di-
masukkan salah. Password bisa diberikan
dalam format plain ataupun md>5.

Untuk memberikan password dalam for-
mat plain, berikanlah perintah password di-
ikuti oleh password yang diinginkan. Contoh:
password rahasia
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Untuk memberikan password dalam
format md5, berikanlah perintah password,
ditkuti oleh opsi -md5 dan password dalam
format md>5, yang bisa dihasilkan program
grub-md5-crypt.

Contoh:

# grub-md5-crypt

Password:

Retype password:
$1$/MvD0o1$Z04E.crkgNAEeHntiQIHJ.

Untuk langsung memberikan perintah
pada prompt, kita harus menghafal perin-
tah-perintah pada menu entry yang ingin di
boot. Setelah itu, baris demi baris perintah
tersebut harus diberikan pada prompt grub.
Terakhir, setelah semua baris perintah di-
ketikkan, berikanlah perintah ‘boot’.

Namun, menghafal command sepanjang
itu tentunya bukanlah pekerjaan kita yang
paling penting. Alangkah baiknya kalau kita
bisa melakukan load file konfigurasi backup

Contoh entry grub: dengan memberikan perintah berikut pada
password --md5 $1$/MvDol$Z04E. prompt grub
crkqNAEeHntiQIHJ. configfile <FILE>

Sebagai catatan, agar lebih aman, beri-
kanlah hak baca tulis terhadap file menu.lst
hanya untuk root, dengan perintah:

# chown root:root /boot/grub/menu.
1st
# chmod 600 /boot/grub/menu.lst

Sebagai catatan, password juga bisa di-
berikan pada seksi per menu entry, yang
mengakibatkan user harus memasukkan
password agar dapat melakukan booting
menu entry yang diinginkan.

Menu.lst hilang!

Ampun! Kenapa saya menghapus menu.lst

yang begitu penting itu? Jadinya, setiap kali

melakukan booting, yang dijumpai bukan lagi

menu grub yang indah, namun prompt grub.
Penulis beberapa kali menjumpai kasus

tersebut. Apabila kita bisa yakin bahwa

permasalahan terletak pada hilangnya file

menu.lst (bukan yang lebih parah, seperti

permasalahan pada boot sector, internal

grub atau lainnya), kita masih bisa setidak-

nya melakukan tiga hal berikut:

® Boot dengan CD rescue dan meng-copy-kan
kembali menu.Ist dari backup. Tidak punya
back-up? Ambil dari template. Sistem Anda
tidak menyediakan template? Copy dari te-
man. Tidak punya? Ketik lagi sendiri.

® Langsung memberikan perintah pada
prompt, seperti yang ditemukan pada
menu entry.

® [oad file konfigurasi back-up langsung
dari prompt grub, tentunya, selama
Anda memiliki back-up file tersebut.

Melihat kemungkinan hilangnya file
menu.lst tersebut, tentunya kita perlu me-
nyiapkan back-up.

Contoh:
configfile (hd@,@)/root/BACKUP/
SYSTEM/GRUB/menu.1st

Device yang dipergunakan, seperti (hd0,0)
tentunya harus merujuk kepada aturan GRUB.
Singkatnya, umumnya, hda (atau, kalau SCSI:
sda) akan dipetakan sebagai hd0 dan par-
tisi akan dimulai dari 0. Bacalah dokumentasi

grub untuk informasi selengkapnya.

Mengedit langsung menu entry
Kita bisa langsung mengedit menu entry di
grub (tentunya, setelah mengisikan pass-
word yang benar, apabila password diguna-
kan). Hal ini akan sangat berguna terutama
ketika Anda ingin memberikan parameter-
parameter spesial dan atau temporer ke ker-
nel atau sistem yang Anda gunakan.
Untuk mengedit perintah menu entry,
lakukanlah langkah-langkah berikut ini:
® Dilihlah entry yang ingin diedit.
® Tekan tombol e untuk mengedit.
® Baris-baris perintah untuk menu entry ter-
pilih akan ditampilkan. gunakan tombol
panah untuk navigasi.
® Tekan tombol o untuk menambah
baris baru setelah baris aktif.
® Tekan tombol O untuk menambah
baris baru sebelum baris aktif.
® Tekan tombol d untuk menghapus
baris aktif.
® Tekan tombol b untuk boot.
® Tekan tombol ESC untuk membatal-
kan perubahan dan kembali ke dialog

sebelumnya.

Di samping nilai gunanya, kemampuan
untuk mengedit menu GRUB, terutama pada
command line kernel, bisa menjadi sangat ber-

bahaya. Beberapa sistem menjadi sangat mu-
dah bobol hanya dengan beberapa perintah
yang bertujuan untuk mengalihkan init atau-
pun pengaturan runlevel tertentu. Beberapa
sistem telah memiliki proteksi tertentu. Na-
mun, secara umum tetap berbahaya.

Oleh karena itu, untuk alasan keamanan,
selalu gunakan password untuk boot loader
(lebih jauh: dan bios untuk password dan boot
device, dan casing komputer, dan ruang kom-
puter dan lokasi penyimpanan komputer).

Grubonce
Beberapa desktop populer menawarkan boot
ke sistem operasi lain, yang terdaftar pada
menu.lst, ketika perintahlogout/reboot diberi-
kan. Ketika kita memilih entry lain misalnya,
komputer akan di-reboot dan lalu, entry yang
kita pilih sebelumnya akan diboot. Menarik
sekali, karena kita tidak perlu secara manual
memilih pada saat boot. Terutama, kalau en-
try yang dipilih bukanlah entry default.
Sebenarnya, untuk kebutuhan tersebut,
kita bisa mempergunakan tool yang telah
disediakan, yaitu grubonce. Sesuai namanya,
perintah ini akan memungkinkan kita untuk
boot pada menu entry yangkita tentukan pada
boot selanjutnya. Setelah boot selanjutnya di-
lakukan, pengaturan kembali ke normal.
Apabila dijalankan (sebagai root) tanpa
parameter apapun , program grubonce akan
menampilkan entry yang tersedia. Contoh:
# grubonce
@: openSUSE 1@.2 (hdal)
1: openSUSE 10.2 (hda7)
2: Debian GNU/Linux 3.1 (hda6)
3: Windows

Selanjutnya, untuk boot ke entry tertentu,
berikanlah parameter (berupa nomor urut)
ketika menjalankan grubonce. Contoh:

Contoh:

# grubonce 3
Using entry #3: Windows

Sebagai catatan: kita bisa tetap bekerja.
Komputer tidak akan di-reboot ataupun d-
shutdown sampai kita melakukannya sendiri.
Boot berikutnya, menu entry yang kita pilih
akan di-boot.

Sampai di sini dulu pembahasan kita.
GRUB sendiri adalah sistem yang kompleks.
Rujuklah kepada dokumentasi GRUB untuk
informasi selengkapnya. Selamat mencoba! o)

Noprianto [noprianto@infolinux.co.id
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Bagian 1 dari 2 artikel

ogical Volume Manager atau yang biasa disingkat dengan LVM merupakan metode

alokasi kapasitas di suatu media penyimpanan, yang lebih fleksibel daripada skema

partisi konvensional. Dengan menggunakan LVM, kita dapat dengan mudah mengubah

kapasitas harddisk tanpa perlu khawatir kehilangan data.

Kesulitan utama pada saat instalasi Linux
yang dirasakan oleh kebanyakan pengguna
Linux adalah pada saat melakukan partisi
harddisk. Diperlukan estimasi yang tepat
dalam menentukan berapa banyak space yang
dibutuhkan untuk file system, dan user file
yang dapat membuat proses instalasi menjadi
lebih kompleks.

Setelah user menentukan berapa banyak
kapasitas yang dibutuhkan untuk partisi /
home, /usr, dan /, pada suatu saat salah satu
partisi di harddisk tersebut akan penuh dan
beberapa partisi masih memiliki kapasitas
yang cukup.

Salah satu cara agar suatu partisi
yang penuh dapat menggunakan kapasi-
tas yang masih kosong di partisi lainnya
adalah dengan menggunakan LVM. LVM
adalah metode alokasi kapasitas media pe-
nyimpanan, yang dapat kita gunakan untuk
menambah, menghapus, dan mengubah
kapasitas partisi pada saat kita butuhkan.
Dengan menggunakan LVM, maka kapa-
sitas harddisk akan di alokasikan ke single
volume group dan logical volume yang dibuat
untuk menyatukan partisi /home, /usr, dan
/, dalam contoh kasus di atas.

Sebagai contoh, jika partisi /home telah
penuh, maka dimungkinkan untuk meng-
gunakan kapasitas di partisi /usr yang
masih tersedia, dengan jalan mengurangi
partisi /usr sesuai kapasitas yang dibutuh-
kan, dan dialokasikan kapasitas tersebut ke
partisi /home. Cara lainnya adalah dengan
mengalokasikan kapasitas minimal un-

tuk tiap logical volume, dan membiarkan
beberapa kapasitas disk unallocated. Dan
disaat partisi tersebut penuh, maka partisi
tersebut akan dapat bertambah pada saat
dibutuhkan.

Untuk lebih memahami cara kerja LVM,
pada tutorial kali ini InfoLINUX akan mem-
bahas cara kerja LVM berikut dengan cara
penggunaannya.

LVM layout

Terdapat beberapa istilah yang perlu Anda

ketahui dalam penggunaan LVM. Beber-

apa terminologi yang perlu diketahui di

antaranya:

® DPhysical volumes
Istilah ini mengacu pada physical disks,
atau disk partitions, seperti /dev/hda, /
dev/hdbl, dan sebagainya. Dengan LVM,
kita dapat mengombinasikan beberapa
physical volume ke dalam volume groups.

® Volume groups
Istilah ini mengacu ke real physical volumes
dan media penyimpanan yang digunakan
untuk membuat logical volumes. Kita
dapat mengasumsikan volume groups se-
bagai sebuah partisi virtual yang mengacu
ke sebuah physical volume.

® [ogical volumes
Istilah ini mengacu pada volume yang
dapat Anda akhiri kapan saja pada saat
proses mount yang sedang terjadi pada
sistem Anda. Logical volume ini dapat
ditambah, dihapus, dan diubah ukurannya
pada saat berjalan.

Logical Volume(s) |1 idevifiesenverishare!
Volume Group(s)

Physical Volume(s)
Skema LVM yang akan dibuat.

fileserver

Untuk lebih memahamiistilah di atas, per-
hatikan Gambar-1. Pada Gambar-1 dimisal-
kan Anda memiliki beberapa physical volu-
me (sebagai contoh /dev/sdbl-/dev/sdel),
dan dalam physical volume ini, kita dapat
menciptakan satu atau lebih volume groups
(sebagai contoh fileserver), dan dalam se-
tiap volume group Anda dapat menciptakan
satu atau lebih logical volumes.

Jika kita menggunakan beberapa physi-
cal volume, setiap logical volume dapat lebih
besar ukurannya dibandingkan salah satu
partisi yang terdapat pada physical volume
(tentu saja jumlah kapasitas total dari logi-
cal volumes tidak boleh melebihi dari jum-
lah kapasitas total dari physical volumes).
Sebagai langkah yang baik, jangan alokasi-
kan semua kapasitas harddisk ke logical vo-
lumes, tetapi sisakan beberapa space yang
tidak digunakan. Dengan cara ini, kita dapat
menambah kapasitas ke satu atau beberapa
logical volumes di kemudian hari.

Sebagai contoh di sini, kita akan mem-
buat sebuah volume group yang bernama
fileserver. Di volume group ini, kita akan
membuat logical volumes /dev/fileserver/
share, /dev/fileserver/backup, /dev/fileser-
ver/backup, dan /dev/fileserver/media (yang
mana hanya akan kita gunakan setengah dari
kapasitas yang ditawarkan oleh physical vo-
lume kita saat ini. Dengan cara ini, nantinya
kita dapat berpindah ke RAID1).
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Persiapan

Dalam DVD InfoLINUX edisi ini, kami telah
menyertakan file Debian_Etch_LVM.zip,
yang berisikan Debian Etch VMware image
yang akan digunakan dalam tutorial ini. Ima-
ge file ini dapat Anda buka menggunakan
VMWare Player yang dapat di-download
dari url http://www.vmware.com/products/
player/. Untuk cara menggunakan VMWare
Player, Anda dapat mempelajarinya dari
url berikut, http://www.howtoforge.com/im-
port_vmware_images.

Sistem ini memiliki enam buah SCSI
harddisk, yaitu /dev/sda-/dev/sdf. Partisi
/dev/sda akan digunakan untuk sistem
Debian Etch, dan partisi /dev/sdb-/dev/
sdf untuk LVM dan RAID. Partisi /dev/
sdb-/dev/sdf memiliki kapasitas sekitar
80 GB.

Sebagai contoh awal, kita akan meng-
gunakan sekitar 25GB kapasitas yang terse-
dia dari masing-masing harddisk. Dalam
contoh ini kita juga akan mendemonstra-
sikan bagaimana cara memindahkan kapa-
sitas dari harddisk yang berukuran kecil ke
harddisk yang berukuran lebih besar (se-
bagai contoh, memindahkan harddisk yang
memiliki kapasitas 25 GB ke harddisk yang
memiliki kapasitas 80 GB).

Konfigurasi LVM

Kami anggap, Anda sudah dapat meng-
instalasi VMWare Player dengan baik.
Jalankan VMWare Player, lalu klik menu
File -> Open. Pilih file Other Linux 2.6.x
kernel.vmx, yang terdapat pada direktori
Debian Etch VMware image, yang telah
Anda ekstrak.

Klik icon Power On untuk mulai men-
jalankan Debian Etch VMware image.
Setelah menampilkan login prompt, login
dengan username ‘root’ dan password how-
toforge’ (jangan sertakan tanda kutip).

Setelah masuk ke prompt, jalankan pe-
rintah berikut untuk merubah keyboard
keymap ke US English.

# dpkg-reconfigure console-data

Pada halaman Configuring console-data,
pilih Select keymap from arch list. Setelah itu,
pilih gwerty pada pilihan Keyboard layout
family. Pilih US american pada pilihan Key-
board layout. Pada keyboard variant, pilih
Standard. Terakhir pada pilihan Keymap,
pilih Standard.

Setelah keymap keyboard Anda sudah ter-
konfigurasi dengan baik, sekarang kita akan
mulai masuk pembahasan utama. Pertama,
jalankan perintah fdisk untuk melihat infor-
masi yang terdapat di harddisk Debian Etch
VMWare image.
serverl:~# fdisk -1

Dari hasil output perintah di atas, dapat
terlihat kalau belum terdapat partisi sama
sekali pada harddisk /dev/sdb-/dev/sdf. Un-
tuk itu, kita akan membuat partisi /dev/sdb1,
/dev/sdcl, /dev/sddl, /dev/sdel, dan mem-
biarkan /dev/sdf. Sebagai latihan, kita akan
membuat kapasitas sebesar 25 GB yang akan
diberikan ke partisi /dev/sdbl-/dev/sdel.
Jalankan perintah berikut, untuk mulai mem-
buat partisi harddisk:
serverl:~# fdisk /dev/sdb

Command (m for help): n

(Note : ketikkan n untuk membuat
sebuah partisi baru)

Command action

e extended
p primary partition (1-4)

p
Partition number (1-4): 1

(Note : ketikkan p, kemudian pilih
1, untuk membuat sebuah partisi di
primary partition di partisi ke-1)

First cylinder (1-10443, default 1):
Using default value 1

Last cylinder or +size or +sizeM or
+sizeK (1-10443, default 10443):
+25000M

(Note : Tekan 1 atau isikan 1 untuk
first cylinder, kemudian isikan
+25000M untuk membuat partisi
sebesar 25GB)

Command (m for help): t

Selected partition 1

Hex code (type L to Tist codes): 8e
Changed system type of partition 1
to 8e (Linux LVM)
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Ambil alih
Hak kendali
Anda*

Open source tidak lagi
dapat dihindari. Kode
pemrogramannya terbuka:
Anda dapat menelitinya,
anda dapat melakukan
perubahan, anda dapat
belajar dari kode tersebut.
Kesalahan ditemukan
lebih dini dan dijperbaiki
lebih cepat.

Open source mengembalikan
kedaulatan anda!.

Apabila anda tidak menyukai
layanan vendor tertentu,
dengan infrastruktur yang ada
anda dapat berpaling ke
vendor yang lain.

Tidak lagi ada perdebatan
soal nilai proyek, tidak lagi
ada ketergantungan terhadap
teknologi tertentu dan

tidak lagi ada monopoli.

Open Source:

GudangLinuX
freedom forever

www.gerbanglinux.com
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a Supriyanto@exampler~
Fle Edit View Terminal Tabs Help

serverl:~# fdisk /dev/sdb

The number of cylinders for this disk is set to 10443.
There is nothing wrong with that, but this is larger than 1024,

and could in certain setups cause problems with:

1) software that runs at boot time (e.g., old versions of LILO)
2) booting and partitioning software from other 0Ss

Fle Edit Vi rminal Tabs Help

serverl:~# pvdisplay

B serverl:~# pvcreate /dev/sdbl /dev/sdcl /dev/sddl /dev/sdel =
Physical volume "/dev/sdbl" successfully created
Physical volume "/dev/sdcl" successfully created
Physical volume "/dev/sddl" successfully created
Physical volume "/dev/sdel" successfully created

-- NEW Physical volume ---

supriyanto@example:~

(e.g., DOS FDISK, 0S/2 FDISK) S‘é x:mg /dev/sdb1
Command (m for help): m :\{lgxi:;iable ﬁg_zg cB
Command action PE Size (KByte) )

a toggle a bootable flag Total PE 9

b  edit bsd disklabel Free PE 0

[ toggle the do; ;ompatibility flag Allocated PE )

d delete a partition PV UUID dyYe5r-iAsD-zMa@-E4Iq-NON2-gl6h- ZNxRoe

1 11§t knovyn partition types

m  print this menu -- NEW Physical volume ---

n add a new partition PV Name /dev/sdcl

o create a new empty DOS partition table 1 VG Name -4

p print the partition table E PV Size 23.29 GB [

q quit without saving changes & Allocatable NO &
Proses pembuatan partisi sebesar 25 GB ke empat buah harddisk. Pembuatan partisi LVM dan menampilkan hasilnya.

Buat kembali, dengan menggunakan pe-

(Note : Isikan t untuk memberikan Device Boot Start rintah pvcreate.
sistem di partisi yang baru saja End Blocks Id System serverl:~# pvcreate /dev/sdbl
kita buat. Lalu isikan 8e di /dev/sdel 1 /dev/sdcl /dev/sddl /dev/sdel
option Hex code untuk memberikan 3040 24418768+ 8e Linux LVM

Linux LVM sebagai file systemnya).

Command (m for help): w
The partition table has been
altered!

Disk /dev/sdf doesn’t contain a va
1id partition table

Untuk melihat status saat ini yang ter-
jadi pada physical volume Anda, jalankan
perintah pvdisplay.
serverl:~# pvdisplay

Dari hasil output perintah di atas, dapat

--- NEW Physical volume ---

(Note : Isikan w untuk menulis terlihat kalau kita sudah berhasil membuat PV Name /dev/sdel
semua perubahan option yang telah partisi sebesar 25 GB di masing-masing par- VG Name

dilakukan di fdisk). tisi /dev/sdb1-/dev/sdel. PV Size 23.29 GB
................................... Berikutnya, kita akan membuat sebuah Allocatable NO
................................... partisi baru untuk LVM. PE Size (KByte) g

Calling ioct1() to re-read serverl:~# pvcreate /dev/sdbl Total PE /]
partition table. /dev/sdcl /dev/sddl /dev/sdel Free PE g

Syncing disks. Physical volume “/dev/sdbl” Allocated PE g

successfully created PV UUID 0YJDSN-

Setelah membuat partisi /dev/sdbl
sebesar 25 GB di /dev/sdb, lakukan hal yang
sama untuk membuat partisi sebesar 25GB
di /dev/sdc-/dev/sde.
serverl:~# fdisk /dev/sdc
serverl:~# fdisk /dev/sdd

Physical volume “/dev/sdcl”
successfully created

Physical volume “/dev/sddl”
successfully created

Physical volume “/dev/sdel”
successfully created

serverl:~# fdisk /dev/sde

Kemudian jalankan perintah berikut un-
tuk melihat apakah partisi yang baru saja
dibuat sudah ada.
serverl:~# fdisk -1

Sebagai latihan untuk menghapus par-
tisi LVM yang baru saja Anda buat, jalankan
perintah berikut:
serverl:~# pvremove /dev/sdbl
/dev/sdcl /dev/sddl /dev/sdel

Labels on physical volume “/dev/
sdbl” successfully wiped

Disk /dev/sde: 85.8 GB,
85899345920 bytes

Labels on physical volume “/dev/
sdcl” successfully wiped

VjST-ufA6-AFBK-i0Ef-K7WA-Npc5S@

Langkah selanjutnya, kita akan membuat
sebuah volume group bernama fileserver
dan menambahkan partisi /dev/sdb1-/dev/
sdel ke dalam volume group fileserver.
serverl:~# vgcreate fileserver
/dev/sdbl /dev/sdcl /dev/sddl
/dev/sdel

Volume group “fileserver”
successfully created

Untuk melihat status volume group yang
baru dibuat, jalankan perintah berikut:
serverl:~# vgdisplay

--- Volume group ---

255 heads, 63 sectors/track, 10443 Labels on physical volume “/dev/ VG Name fileserver
cylinders sdd1” successfully wiped System ID
Units = cylinders of 16065 * 512 = Labels on physical volume “/dev/ Format Tvm2

8225280 bytes

sdel” successfully wiped
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Fle Edit View Terminal Tabs Help
Logical volume "share" created
Logical volume "backup" created
Logical volume "media" created

serverl:~# lvdisplay
--- Logical volume ---

LV Name

VG Name fileserver
LV UUID

LV Write Access read/write
LV Status available
# open [¢]

LV Size 40.00 GB
Current LE 10240
Segments 2
Allocation inherit
Read ahead sectors 0

Block device 2530

serverl:~# lvcreate --name share --size 40GB fileserver =
serverl:~# lvcreate --name backup --size 5GB fileserver

serverl:~# lvcreate --name media --size 1GB fileserver

/dev/fileserver/share

Da0Ok1-WAP6-Fau5-8cOF-x4Kg-0DW3-0bP115

su;r&a;w;én,‘fe);ﬂpile::;~

]

(&I

Pembuatan logical volume di volume group file server.

Free PE / Size 23844 / Volume group “data” successfully
93.14 GB removed
VG UUID 6Ne4 jD-

9DGL-1Kku-Wxwl-Yh39-8T4Y-VsTfdL

Perintah lainnya, yang dapat digunakan
untuk men-scan volume group yang terdapat
pada harddisk dan rebuild caches adalah vgs-
can.
serverl:~# vgscan

Reading all physical volumes.

This may take a while...

Untuk memastikan kalau volume group
data sudah tidak terdapat lagi pada harddisk,
Anda dapat menggunakan perintah vgdisplay
dan vgscan. Setelah itu, buat kembali volume
group fileserver yang telah dijelaskan sebe-
lumnya, dengan menggunakan vgcreate.
serverl:~# vgcreate fileserver
/dev/sdbl /dev/sdcl /dev/sddl
/dev/sdel

Found volume group “fileserver”
using metadata type Tvm2

Volume group “fileserver”
successfully created

Untuk latihan, kita juga dapat mengubah
name volumegroup fileserver menjadi nama
lainnya (misal data), dengan menggunakan
vgrename.
serverl:~# vgrename fileserver data

Volume group “fileserver”
successfully renamed to “data”

serverl:~# vgdisplay
--- Volume group ---

Selanjutnya kita akan mempelajari cara
membuat logical volume. Sebagai latihan,
kita akan membuat logical volumes ber-
nama share (40 GB), backup (5 GB), dan
media (1 GB) dalam volume group fileserver.
Ketiga logical volume ini hanya menggu-
nakan kapasitas yang tidak mencapai 50%
dari kapasitas yang tersedia (yang nantinya
dapat digunakan untuk membuat RAID1).
Untuk membuat logical volumes yang telah

menggunakan perintah lvdisplay.
serverl:~# lvdisplay
--- Logical volume ---

LV Name /dev/
fileserver/share

VG Name fileserver

Read ahead sectors ]

Block device 253:2

Perintah lainnya, yang dapat digunakan
untuk menscan logical volume yang ter-
dapat pada harddisk adalah lvscan.
serverl:~# lvscan

ACTIVE ‘/dev/
fileserver/share’ [40.00 GB]
inherit

ACTIVE ‘/dev/
fileserver/backup’ [5.00 GB]
inherit

ACTIVE ‘/dev/
fileserver/media’ [1.00 GB]
inherit

Untuk latihan, kita akan mengubah logical
volume yang bernama media menjadi films
dengan menggunakan perintah lvrename.
serverl:~# Tvrename fileserver
media films

Renamed “media” to “films” in
volume group “fileserver”

serverl:~# lvdisplay

--- Logical volume ---
LV Name
fileserver/films

/dev/

Lalu, hapus logical volume films.
serverl:~# lvremove /dev/
fileserver/films

VG Name data disebutkan, jalankan perintah berikut: Do you really want to remove
System 1D serverl:~# Tvcreate --name share active logical volume “films”?
Format 1vm2 --size 40G fileserver [y/n]: y
................................... Logical volume “share” created Logical volume “films”
Free PE / Size 23844 / serverl:~# lvcreate --name backup successfully removed
93.14 GB --size 5G fileserver
VG UUID 6Ned jD- Logical volume “backup” created Buat kembali logical volume media.

9DGL-1KKku-Wxwl-Yh39-8T4Y-VsTfdL

Sebagai latihan, kita juga dapat meng-
hapus volume group data dengan meng-
gunakan perintah vgremove
serverl:~# vgremove data

serverl:~# lvcreate --name media
--size 1G fileserver

serverl:~# lvcreate --name media
--size 1G fileserver

Logical volume “media” created

Logical volume “media” created

Untuk mengetahui informasi logical
volumes yang baru saja dibuat, Anda dapat

Sekarang kita akan menambah kapasitas
logical volume media dari 1 GB menjadi 1.5
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GB dengan menggunakan perintah lvex-
tend.
serverl:~# lvextend -L1.5GB /dev/

fileserver/media

mkfs.reiserfs 3.6.19 (2003 www.
namesys.com)

5.06G
5.0G 1% /var/backup

144K

/dev/mapper/fileserver-media

Extending logical volume media
to 1.50 GB

ReiserfFS is successfully created on
/dev/fileserver/media.

Logical volume media
successfully resized

Kurangi kembali ukurannya menjadi
berukuran 1GB dengan menggunakan pe-
rintah Ivreduce.
serverl:~# Tvreduce -L1G /dev/
fileserver/media

WARNING: Reducing active logical
volume to 1.00 GB

THIS MAY DESTROY YOUR DATA
(filesystem etc.)

Do you really want to reduce

Sekarang kita siap untuk melakukan
mount ke logical volumes. Contoh, kita akan
melakukan mount logical volume share ke /
var/share, backup ke /var/backup, dan media
ke /var/media. Untuk itu, kita harus mem-
buat semua direktori itu terlebih dahulu.
serverl:~# mkdir -p /var/media
/var/backup /var/share

1.86 33M

992M 4% /var/media

Sampaisaatini, kitasudah mengonfigura-
si sistem LVM pertama kita. Sekarang, Anda
dapat membaca dan menulis dari partisi
/var/share, /var/backup, dan /var/media.

Agar proses mount partisi /var/share, /
var/backup, dan /var/media, dapat berjalan
secara otomatis, Anda dapat menambahkan
baris berikut ke dalam file /etc/fstab.
serverl:~# vim /etc/fstab

Sekarang, kita dapat memproses mount
ke logical volume yang baru saja dibuat.
serverl:~# mount /dev/fileserver/

# /etc/fstab: static file system
information.

media? [y/n]: y share /var/share /dev/fileserver/share /var/share
Reducing logical volume media to serverl:~# mount /dev/fileserver/ ext3 rw,noatime 00

1.00 GB backup /var/backup /dev/fileserver/backup /var/
Logical volume media serverl:~# mount /dev/fileserver/ backup xfs rw,noatime

successfully resized media /var/media 00

/dev/fileserver/media /var/media

Sampai saat ini kita telah memiliki tiga Jalankan juga perintah di bawah ini un- | reiserfs rw,noatime g9

buah logical volume. Tetapi, ketiga buah | tuk melihat sisa kapasitas logical volumes

logical volume tersebut belum memiliki file- | yang baru saja kita mount. Setelah komputer restart, secara oto-

system sehingga kita tidak dapat melakukan
save file apapun pada logical volume terse-
but. Untuk itu, kita akan memberikan ext3
filesystem pada logical volume di share, xfs
filesystem di backup, dan reiserfs filesystem
di media.

serverl:~# mkfs.ext3 /dev/
fileserver/share

$ df -h

Filesystem Size Used
Avail Use% Mounted on
/dev/mapper/fileserver-share

406G 176M

38G 1% /var/share

mke2fs 1.40-WIP (14-Nov-2006)

/dev/mapper/fileserver-backup

Filesystem label=
0S type: Linux

Use tune2fs -c or -i to override.

serverl:~# mkfs.xfs /dev/
fileserver/backup
meta-data=/dev/fileserver/
backup isize=256 agcount=8,
agsize=163840 blks

realtime =none
extsz=65536 blocks=@, rtextents=f§

serverl:~# mkfs.reiserfs /dev/
fileserver/media

matis ketiga partisi tersebut akan lang-
sung ter-mount pada direktori yang telah
disebutkan.

Mengubah ukuran logical volumes
dan filesystem

Setelah kita mengetahui konsep dasar LVM.
berikutnya kita akan belajar cara mengubah
ukuran logical volume share yang meng-

suprlyantz@;(;m;ie: =

Fle Edit View Terminal Tabs Help

serverl:~#
serverl:~#
serverl:~#

/dev/mapper/fileserver-backup

serverl:~# [|

mkdir /var/media /var/backup /var/share
mount /dev/fileserver/share /var/share
mount /dev/fileserver/backup /var/backup

Avail Use%

serverl:~# mount /dev/fileserver/media
serverl:~# df -h
Filesystem Size Used
/dev/sda2 19G 666M 176G
tmpfs 78M 0 78M
udev 160M 88K 10M
tmpfs 78M 0 78M
/dev/sdal 137M  17M 114M
/dev/mapper/fileserver-share

406G 177M  38G

5.06 144K 5.0G
/dev/mapper/fileserver-media
1.0G 33M 992M

/var/media

Mounted on
4%
0%
1%
0%

13%

yi
/lib/init/rw
/dev
/dev/shm
/boot

1% /var/share

1% /var/backup

4% /var/media

T

Mounting tiga volume LVM ke direktori yang ada di /var.
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supriyanto@example:~

Fle Edit View Jerminal Tabs Help
Pass 4: Checking reference counts
Pass 5: Checking group summary information

3107200 blocks

serverl:~# resize2fs /dev/fileserver/share
resize2fs 1.40-WIP (14-Nov-2006)

The filesystem is already 13107200 blocks long.

serverl:~# df -h

/dev/mapper/fileserver-backup

/dev/mapper/fileserver-media

5 33M

/dev/mapper/fileserver-share
506G 180M  47G

serverl:~#

/dev/fileserver/share: 11/6553600 files (9.1% non-contiguous), 251730/1

serverl:~# mount /dev/fileserver/share /var/share/

Filesystem Size Used Avail Use% Mounted on
/dev/sda2 196 666M 176 4% /

tmpfs 78M 0 78M 0% /lib/init/rw
udev 16M 88K 16M 1% /dev

tmpfs 78M 0 78M 0% /dev/shm
/dev/sdal 137M 17M 114M 13% /boot

5.06 144K 5.0G 1% /var/backup
992M 4% /var/media B

1% /var/share

Fle Edit View Terminal Tabs Help

D!

Nothing to do!

3107200 blocks

serverl:~#

serverl:~# umount /var/share/

serverl:~# e2fsck -f /dev/fileserver/share

e2fsck 1.40-WIP (14-Nov-2006)

Pass 1: Checking inodes, blocks, and sizes

Pass 2: Checking directory structure

Pass 3: Checking directory connectivity

Pass 4: Checking reference counts

Pass 5: Checking group summary information

/dev/fileserver/share: 11/6553600 files (9.1% non-contiguous), 251736/1

serverl:~# resize2fs /dev/fileserver/share 10485760
resize2fs 1.40-WIP (14-Nov-2006)
Resizing the filesystem on /dev/fileserver/share to 10485760 (4k) block

s.
The filesystem on /dev/fileserver/share is now 10485760 blocks long.

serverl:~# lvreduce -L40G /dev/fileserver/share
WARNING: Reducing active logical volume to 40.00 GB
THIS MAY DESTROY YOUR DATA (filesystem etc.)

Do you really want to reduce share? [y/n]: y L
Reducing logical volume share to 40.00 GB
Logical volume share successfully resized

supriyanto®example:~

D]

Merubah ukuran logical volume share dan melihat kapasitasnya.

gunakan ext3 filesystem. Sebelum melaku-
kan hal ini, lakukan proses umount partisi
tersebut terlebih dahulu.

serverl:~# umount /var/share

Berikutnya, kita akan menambah kapasi-
tas logical volume share dari 40 GB menjadi
50 GB. Untuk mengubah kapasitas logical
volume, Anda dapat menggunakan perintah
lvextend.
serverl:~# lvextend -L50G /dev/
fileserver/share

Extending logical volume share to
50.00 GB

Logical volume share successfully
resized

Saat ini, kita hanya membesarkan logi-
cal volume share, bukan ext3 filesystem
yang terdapat di share. Untuk itu, kita akan
mengubah juga besar ext3 filesystem yang
terdapat pada logical volume share.
serverl:~# e2fsck -f /dev/
fileserver/share

Memperkecil ukuran logical volume share, dan melihat kapasitasnya saat di mount.

Resizing the filesystem on /dev/
fileserver/share to 13107200 (4k)
blocks.

Resizing the filesystem on /dev/
fileserver/share to 10485760 (4k)
blocks.

The filesystem on /dev/fileserver/
share is now 13107208 blocks Tlong.

The filesystem on /dev/fileserver/
share is now 10485768 blocks Tong.

Mount kembali partisi tersebut.
serverl:~# mount /dev/fileserver/
share /var/share

Pada saat kita melihat kapasitas yang
terdapat pada logical volume share yang di-
mount, dapat terlihat kalau kapasitas logi-
cal volume share sudah berubah menjadi 50
GB, dari sebelumnya yang hanya 40 GB.

Selain memperbesar kapasitas logical
volume, kita juga dapat memperkecil kapa-
sitas logical volume. Sebagai contoh, kita
akan memperkecil kapasitas logical volume
share menjadi 40 GB kembali.

Pertama, umount kembali logical volu-
me share yang telah di-mount ke partisi
/var/share.
serverl:~# umount /var/share

e2fsck 1.40-WIP (14-Nov-2006)

/dev/fileserver/share: 11/5242880
files (9.1% non-contiguous),
209588/1048576@ blocks

Lakukan check partisi logical volume
share.
serverl:~# e2fsck -f /dev/
fileserver/share

Catat total blocks yang terdapat pada
partisi tersebut (10485760), yang kita
butuhkan untuk memperkecil kembali uku-
ran logical volume tersebut nanti. Sekarang,
lakukan perubahan ukuran ext3 filesystem
logical volume share.
serverl:~# resize2fs /dev/
fileserver/share

Sekarang kita akan mengubah ukuran
ext3 filesystem logical volume share men-
jadi 40 GB. Dari operasi sebelumnya, kita
sudah mendapat catatan kalau 40 GB sama
dengan 10485760 blocks. Jalankan perin-
tah berikut untuk mengubah ukuran.
serverl:~# resize2fs /dev/
fileserver/share 10485760

resize2fs 1.4@-WIP (14-Nov-2006)

resize2fs 1.4@0-WIP (14-Nov-2006)

Setelah memperkecil kapasitas filesys-
tem, kita juga perlu memperkecil ukuran
logical volume-nya juga. Jalankan perintah
berikut untuk melakukannya.
serverl:~# lvreduce -L48G /dev/
fileserver/share

WARNING: Reducing active logical
volume to 40.00 GB

THIS MAY DESTROY YOUR DATA
(filesystem etc.)

Do you really want to reduce share?
Ly/n]: <--y

Reducing logical volume share to
40.00 GB

Logical volume share successfully
resized

Setelah melakukan langkah di atas,
mount kembali partisi logical volume share
yang sudah diperkecil kembali ukurannya.
serverl:~# mount /dev/fileserver/
share /var/share

Selanjutnya, lihat status kapasitas par-
tisi yang baru saja dirubah.
serverl:~# df -h

Sampai disini dahulu tutorial LVM un-
tuk edisi ini. Pada bagian berikutnya, kita
akan mempelajari metode penggunaan
LVM yang lain, dalam memanajemen kapa-
sitas harddisk. Sampai jumpa !. A

Supriyanto [supriyanto@infolinux.co.id]
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lot dan analisis data biasanya digunakan untuk membantu dalam interpretasi data.

Microcal Origin adalah perangkat lunak untuk plot dan analisis data di lingkungan

Windows yang luar biasa. Sayangnya, Microcal Origin hanya dibuat untuk Windows

dan tidak gratis. Bagaimana dengan aplikasi serupa di Linux?

Ada beberapa perangkat lunak yang sama
fungsinya dengan Microcal Origin, salah sa-
tunya adalah SciGraphica.

1. Instalasi

Sampai saat ini SciGraphica sudah meri-
lis versi 2.1.0. Namun, Anda dapat men-
download SciGraphica versi 2.0.0 yang
sudah stabil di situs sourceforge.net. Tiga
paket yang harus Anda download un-
tuk instalasi Scigraphica versi 2.0.0 yaitu
gtk+extra-2.0.0.tar.gz (873,3 KB), libsci-
graphica-2.0.0.tar.gz (758.0 KB) dan sci-
graphica-2.0.0.tar.gz (526.2 KB). Lakukan
instalasi untuk ketiga paket tersebut secara
berurutan dengan perintah berikut ini:

# tar -xzvf namapaket-2.0.0.tar.gz
# ./configure

# make

# make check

juga Anda instalasikan Python serta paket
pendukungnya.

2. Mari Memulai

Penulis melakukan instalasi SciGraphica di
RedHat 9, Untuk memulainya di terminal
berikan perintah berikut:

$ /usr/local/bin/scigraphica &

Kali pertama Anda akan disuguhi GUI
dari SciGraphica (Gambar 1), Anda dapat
membuka Worksheets tempat memasukkan
data dengan melakukan klik dua kali pada
icon Worksheets. Penulis mencoba dengan
memasukkan data yang sederhana seperti
pada Gambar 2. Simpan dan beri nama pe-

kerjaan Anda (File > Save as).

Fie Edit Help

© \d 3 & | 5 (=]

New Open  Save  Worksheet Matrix B Polar )

# make install (user root)

Karena SciGraphica menggunakan mo-
dul yang ditulis dengan intepreter Python
untuk penyelesaian analisis numerik maka
kegagalan instalasi biasanya karena tidak
adanya salah satu paket pendukung Python,
yaitu Numpy atau Numarray. Anda juga
dapat men-download-nya di sourceforge.net
(numarray-1.5.2.tar.gz (1.1 MB), numpy-
1.0.1.tar.gz (1.2 MB)), Jika Anda tidak ingin
repot Anda juga dapat men-download bi-
nary dari 5 paket tersebut. Jadi sebaiknya,
sebelum melakukan instalasi SciGraphica
selain Anda menggunakan GNOME (Gtk+)

Gambar 1. Graphical User Interface dari SciGraphica.

Setelah itu, lakukan plot untuk data Anda
dengan cara memilih icon 2D kemudian klik
dua kali icon plot hingga tampil layar tempat
plot grafik. Hal pertama yang harus Anda
lakukan sebelum memplot data adalah men-
gatur skala dari grafik plot dengan cara klik
dua kali di daerah grafik plot hingga tampil
Layer Control seperti pada Gambar 3.

Klik Axes kemudian atur skala untuk

sumbu X dan sumbu Y disesuaikan dengan

@ * ® ®© | o B f
Import Export ~ Cut  Copy Paste Recalc Column Values
A~ o] < [ o [ & |M

0 1.000 2.000

1 2.000 4.000

2 3.000 6.000

3 4.000 8.000 Il
4 5.000 10.000
e —1

6

7

8 ]
< ]
B:5

Gambar 2. Memasukkan data pada Worksheets.

data yang telah Anda masukkan pada Work-
sheets penulis mengatur skala sumbu X dari
0 sampai 5 dan skala sumbu Y dari 0 sampai
10, Seperti Gambar 3. Setelah itu, plot data
Anda dengan cara:

Tekan tombol Add dataset untuk ma-
sukkan data yang telah Anda buat.

Kemudian pilih cara data diplot. Penulis
memilih melakukan plot dengan X-Y Scatter.

Setelah data diplot kemudian penulis

mencoba kemampuan Fit Curve dari Sci-
Graphica dengan memilih icon Fit Curve
pada GUI plot.

Karena data yang dibuat adalah data line-

ar, maka penulis melakukan fitting kurva

3

(i axes propert

Gambar 3. Mengatur skala plot untuk grafik.
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2; Pl
3 a8 g | ¢ | ¢ B K
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linear dan hasilnya fitting dan plot ditun-
jukkan seperti Gambar 4 a dan b.

Anda dapat menyimpan hasil plot grafik
tersebut dalam format *.sgp atau Anda juga
dapat meng-export hasil plot grafik tersebut
dalam format lain. Mudah, bukan?

Plot linear adalah contoh yang mudah
sehingga kelebihan Scigraphica tidak dapat
diunggulkan dengan software kelas office
seperti Microsoft Excel atau OpenOffice
Calc. Untuk urusan fitting kurva plot Anda
diberikan banyak fungsi yang kompleks un-
tuk melakukan interpolasi semacam fungsi
kuadratik, logaritmik, eksponensial, atau
bahkan fungsi yang lebih kompleks seperti
Gauss, Boltzmann semua fungsi fitting
kurva tersebut dapat diselesaikan dengan
Scigraphica.

3. Bekerja dengan Layer

Sering kali dalam melakukan plot grafik,
Agar mudah membandingkan dua atau
lebih data. Grafik ditempatkan pada satu
layer baik disatukan atau dipisahkan arti-
nya terdapat dua grafik atau lebih pada satu
layer. Hal ini dapat juga dilakukan oleh Sci-
Graphica dengan cara:

[“@ox [ v apnly ][ x cose |
=

Gambar 5 Mengatur posisi plot grafik dari masing-masing layer.

Klik kanan plot yang telah Anda buat ke-
mudian tambahkan layer baru (Layer > New
> 2D).

Layer baru ini dapat Anda atur posisinya

yaitu dengan cara membuka Layer Control

(klik dua kali plot grafik).

(v HIEIES
Param  Vary Value
a 1.22442e-13

O

‘ <J Prev

‘ > Next H X Cancel

Gambar 4 a dan b. Plot X-Y Scatter dan Hasil Fit Curve pada
Scigraphica dengan data linear.

Atur posisi dari plot tersebut dengan
memilih nama dari plot grafik Anda pada
Tab Position seperti pada Gambar 5.

Penulis melakukan plot dua grafik pada
satu layer dengan terlebih dahulu menam-
bah Worksheets untuk data kedua atau
Anda dapat juga menambahkan data pada
Worksheets yang pertama. Langkahnya
sama seperti dituliskan pada langkah per-
tama dan hasilnya seperti pada Gambar 6.

Layer sangat berguna terutama jika
Anda harus membandingkan dua plot grafik
yang menggunakan sumbu X-Y dengan
range yang sama. Jika data yang Anda buat
diperoleh dari kondisi yang berbeda namun
masih menggunakan parameter yang sama,
maka Anda dapat menyimpulkan pengaruh
yang terjadi akibat pemberian kondisi yang
berbeda tersebut hanya dengan menganali-
sis plot dari data yang berbeda tersebut. Un-
tuk itu Anda perlu menggabungkan grafik
yang Anda miliki. Layer di Scigraphica dapat
dibuat lebih dari dua tergantung kebutuhan
Anda.

4. Plot 3D dan visualisasi kontur

Plot 2D membantu Anda dalam intepretasi

data yang hanya memiliki dua parameter.

Bagaimana untuk data yang memiliki tiga
parameter, katakanlah terdiri dari sumbu
X, Y dan Z? Artinya, Anda memiliki minimal
tiga informasi yang dapat digunakan untuk
interpretasi data. Data dengan tiga parame-
ter dapat divisualisasikan dalam bentuk 3D
ataupun kontur. Scigraphica memberikan
kemudahan untuk melakukan plot 3D atau
visualisasi kontur. Biasanya lebih mudah
melakukan interpretasi data dengan plot
3D atau visualisasi kontur jika memberikan
gradasi warna, dengan demikian warna-
warna tersebut dapat dijadikan indikasi bagi
Anda untuk menganalisis data.

Pengaturan warnapun dapat dilakukan
dengan mudah menggunakan Scigraphica,
Anda hanya perlu memberikan indikasi
warna pada nilai yang Anda miliki. Misalnya
nilai maksimum Anda berikan warna merah
dan nilai minimum diberikan indikasi warna
hijau. Gradasi yang dihasilkan secara oto-
matis akan diselesaikan oleh Scigraphica.
Berikut ini contoh plot 3D dan visualisasi
kontur dengan data yang dimiliki penulis.

Bagaimana dengan plot 3D atau visual-
isasi dalam bentuk kontur. Kebetulan penu-
lis memiliki contoh data 3D yang akan dip-
lot kemudian dibuat juga konturnya. Untuk
melakukan plot 3D, caranya:

Pilih icon 3D lalu klik dua kali icon plot
setelah itu atur skala plot sesuai dengan
data yang ada.

Kemudian pada Add dataset tambahkan
datanya. Anda akan diberikan pilihan untuk
memplot data. Plot 3D Surface untuk plot
3D sedangkan untuk plot 3D dan juga kon-
turnya Anda dapat memilih 3D Contour.
Hasilnya ditunjukkan pada Gambar 7. Seb-
agai perbandingan plot 3D kontur dari Mi-
crocal Origin juga diperlihatkan.

Gradasi warna dapat diatur dengan klik
dua kali hasil plot kemudian pilih (Dataset >

@ @ ] ‘
Cayes: (2 [ e w20 “r e Coyers 2] 2] acve otaset 5 2.0 [~ s e |
150 1o, I” 1s¢ 12 1 I 1250 lo. 1sp, 1100, 4150, 1200,
oy e [l moE .
B[E E=]E)
g H =
=]E) gE A
i & o
Bl KBIRj
KR KBl =
7] 7] A
g  emx ;“ /
i L
< £ | [ I 5
(X¥) = (4.330900,14.401914) 0 (386524 ) _.

Gambar 6. Plot dua grafik dengan penambahan layer.
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Properties) pada Tab Levels + Colors seperti
ditunjukkan Gambar 8.

Anda dapat mengatur skala warna, se-
dangkan penambahan kontur dapat dilaku-
kan dengan memilih Tab Contour dan kos-
tumisasi kontur pun dapat dilakukan.
dalam hal
melakukan plot 3D dan visualisasi kontur

Keunggulan  Scigraphica

adalah data yang digunakan untuk melaku-
kan plot disiapkan dalam format *.dat dan
disusun sesuai dengan parameter yang di-
gunakan. Misalnya kolom pertama untuk
sumbu X, kolom kedua untuk sumbu Y,
dan seterusnya. Hal ini biasa dilakukan jika
Anda mengambil data yang diubah ke for-
mat ASCII sehingga Anda dapat langsung
menggunakannya untuk melakukan plot.
Tidak demikian halnya jika Anda meng-
gunakan Microcal Origin, data yang telah
diformat menjadi ASCII harus terlebih da-
hulu diubah menjadi susunan matrix agar
dapat melakukan plot 3D atau visualisasi
kontur. Ini selain merepotkan juga akan
menambah penuh ruang harddisk Anda un-
tuk menyimpan data matrix tersebut.

Jika ditinjau dari hasil plot Microcal Ori-
gin tidak lebih baik dari Scigraphica. Hal ini
juga yang dibanggakan oleh pembuat Sci-
graphica seperti pada gambar 7 dan 8. Plot
yang dihasilkan Microcal Origin adalah hasil
konversi ke matrix sehingga agak berbeda
dengan plot dari Scigraphica.

5. Microcal Origin dan Scigraphica

Apa yang dikatakan oleh pembuat Scigraph-
ica adalah kloning dari Microcal Origin me-
mang benar adanya. Menurut penulis yang
pernah menggunakan Microcal Origin,
Scigraphica hampir memiliki kemampuan
yang sama dengan Microcal Origin. Misal-

nya untuk urusan fitting kurva fungsi-fung-

si yang disediakan cukup banyak seperti
gauss, boltzmann, dan lain-lain. Kemudian
kemampuan layer dari Scigraphica juga luar
biasa bahkan menurut penulis lebih mudah
dibandingkan Microcal Origin.

Demikian pula dalam hal plot 3D kontur,
Scigraphica dapat langsung melakukan plot
dari data *.dat tidak seperti Microcal Ori-
gin yang mengharuskan data *.dat diubah
terlebih dahulu dalam bentuk matrix. Satu
hal lain yang menarik bagi penulis adalah
plot grafik yang dihasilkan oleh Scigraphica
lebih baik jika dibandingkan dengan plot
grafik Microcal Origin, dilihat dari kualitas
cetaknya.

Bagaimana dengan fungsi-fungsi yang
tidak umum digunakan untuk melaku-

b4 SciGraphica: Layer Control

[Matbazhat) G | N

-\ Gambar 7 a, b, c. Plot 3D dengan dan tanpa kontur dengan Scigraphica
dan Microcal Origin 7.

kan fitting kurva? Jika di Microcal Ori-
gin fungsi tersebut dapat ditambahkan
dengan menggunakan compiler C yang
disertakan sebagai paket Microcal Origin,
maka Scigraphica memiliki intepreter Py-
thon dengan site-package-nya yang luar
biasa dan dapat Anda gunakan untuk di-
jadikan modul sebagai tambahan fungsi
yang Anda perlukan. Dengan masih terus
dikembangkannya SciGraphica yang mem-
berikan lingkungan plot yang WYSIWYG
bukan tidak mungkin keberadaan Micro-
cal Origin dapat digantikan, khususnya
dalam hal perangkat lunak yang dapat
berjalan di banyak platform, dan tanpa
biaya lisensi alias gratis.

Said Sesiaria [sesiaria@gmail.com]

-
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Gambar 8. Pengaturan skala warna untuk plot 3D.
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alah satu keuntungan membeli notebook kosongan (tanpa OS) adalah selain harganya

jauh lebih murah (tapi tidak murahan), juga bebas menentukan pilihan sistem operasi

yang akan digunakan. Berikut ini contoh pengalaman penulis dalam mengonfigurasi

modem internal di sebuah notebook.

Dalam melakukan uji coba, penulis meng-
5583NWXMi.

Notebook ini menjadi pilihan karena spesi-

gunakan notebook Acer

fikasinya cukup bagus, yaitu Processor Intel
Core 2 Duo T5500 (1,66 GHz, 667 MHz FSB,
EMT64, WiFi, i945GM, dan 512 DDR2),
dengan harga cukup murah. Pilihan penulis
jatuh pada distro Linux openSUSE 10.2, yang
dalam satu paket terdiri dari 5 CD dan 1 CD
tambahan. openSUSE 10.2 dirilis akhir De-
sember 2006 dan DVD-nya disertakan dalam
majalah InfoLINUX edisi 02/2007. Spesifikasi
openSUSE 10.2, antara lain: Kernel 2.6.18.2-
34, KDE 3.5, GNOME 2.16, OpenOffice
2.0.4, termasuk driver atau modul kernel
dari Smart Link Soft Modem.

PERMASALAHAN

Proses instalasi openSUSE 10.2 berjalan
mulus. Dan kesan pertama penulis, ini baru
Linux-ku! Giliran setting modem, ternyata
modem-nya tidak langsung dapat diguna-
kan. Bagaimana ini? Upaya pertama penulis
adalah melakukan pengecekan ulang paket-
paket yang sudah terinstalasi, barangkaliada
yang tertinggal, atau masalah dependensi.
Hasilnya tetap, modem tidak dikenali. Ke-
mudian dengan perintah wvdialconf, tidak
menemukan modem. Berikutnya dengan
kppp, hasilnya sama saja.

Penulis kemudian melakukan instalasi
ulang modul smartlink beserta kompilasi
kernelnya. Hasilnya juga sama saja, modem
belum dapat digunakan. Jadi, bagaimana
dong?

Penulis teringat “Praktik Instan” di Info-
LINUX edisi 08/2006 (“Trik Menjinakkan
Modem Internal”). Yah... this is the hard
way to do the right thing. Awalnya penulis
paling malas dengan yang namanya com-
mand line. Justru untuk menghindarinya,
maka penulis memilih openSUSE 10.2.
Dengan adanya masalah modem ini, maka
terpaksa penulis mencoba perintah baris di
terminal.

Setelah berjam-jam mengikuti proses
praktik instan tersebut, hasilnya seperti
berikut ini:

Tinux-ku:/ # cd /sbin
linux-ku:/sbin # modprobe slamr
FATAL: Module slamr not found.
Tinux-ku:/sbin #

Artinya? Ya, gagal lagi! Bagaimana agar
menemukan modemnya, bukankah prose-
dur sebelumya tidak terjadi kesalahan?

Akhirnya, seperti pepatah mengatakan
kepalang basah, mandi saja sekalian! Jadi,
dengan berbekal semangat dan kebulatan
tekad, penulis mencoba dengan cara sen-
diri. Hitung-hitung sambil belajar Linux dan
menambah pengalaman.

PROSEDUR

Langkah pertama, instalasi ulang modul
smartlink modem.

Kedua, melakukan investigasi pustaka
yang berhubungan dengan modem internal
ini. Cara yang paling efektif menggali infor-
masi adalah dari paket modem itu sendiri,

di samping mengumpulkan berbagai hal
yang berhubungan dengan permasalahan
modem internal. Informasi dapat dicari
pada situs-situs forum diskusi dan tanya-
jawab di internet.

Langkah ketiga, berbekal informasi yag
diperoleh, persiapkan jurus-jurusjitu “meng-
oprek” program eksekusi modem.

PENYELESAIAN

Pertama, kenali hardware (modem) yang
kita miliki, bagaimana sistem kerja pada
umumnya, dan pahami dukungan modem
yang dimiliki oleh software.

Dariuser’sguide Aspire 5580/5570/3680
Series yang menyertai Notebook Acer As-
pire 5583NWXMi, spesifikasi modem: 56K
ITU V.92 with PTT approval; wake-on-ring
ready. Maksudnya (secara umum) spesifika-
si tersebut adalah standard modem dial-up
(56 K), versi (ITU V.92), yang aktivitasnya
(Tx/Rx) berdasarkan program (PTT).

Untuk mengetahui di mana lokasi dan
identitas lain dari modem yang terpasang pada
notebook Acer ini tidak perlu membongkar
casing, cukup dengan menggunakan perintah
“aplay -1” sebagai root, seperti berikut ini:

root:/# aplay -1
**xxx List of PLAYBACK Hardware
Devices ***x
card @: Intel [HDA Intel], device
@: ALC883 Analog [ALC883 Analog]

Subdevices: 1/1
Subdevice #@: subdevice #0
card @: Intel [HDA Intel], device
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G YaST2@linux-ku

The Hardware
Information module

& Hardware Information

displays the hardware
details of your computer. All Entries

Click any node for more S Sound

You can save hardware Bus: PCI
information to a file. Click Class (spec):
Save to File and enter the

Drivers

Resources
Revision: 2
Slot ID: 27

Starnan Madia

information © 82801G (ICH7 Family) High Definition Audio Controller

Class: Multimedia controller
filename. Device Identifier (spec): 65808

Device Identifier: 75736

Device: 828016 (ICH7 Family) High Definition Audio Controller
Driver: HDA Inte!

Model: Acer Incorporated [ALI) 828016 (ICH7 Family) High Definition Audio Controlle[ |
Old Unique Key: ufzz.uaGKc7prgvd

Subvendor Identifier: 69669
Subvendor: Acer Incorporated [ALI]

Unique Key: ulNb.uaGKc7prgv

Vendor Identifier: 98438

Vendor: Intel Corporation

bus_hwefg: pei

diiver_module: snd_hda_intel

sysfs_bus_id: 0000:00:1b.0

udi: /org/freedesktop/Hal/devices/pci_8086_27d8

&

Save to File.

Gambar 1. YaST menampilkan informasi hardware.
2: ALC883 Digital [ALC883 Digitall
Subdevices: 1/1
Subdevice #0: subdevice #0
card @: Intel [HDA Intel], device
6: Si3054 Modem [Si3@54 Modem]
Subdevices: #/1
Subdevice #0: subdevice #0

Perintah “aplay -1 menginformasikan
lokasi modem, yang berada pada card:0 dan
device:6. Pada sistem driver ALSA dikenal
sebagai hw:0 (bisa juga ditulis hw:0,6). List
of Playback tersebut juga menginformasikan
bahwa driver modem menggunakan driver
soundcard HDA Intel dengan identitas de-
vice Si3054 Modem.

Selanjutnya perlu diketahui identitas
modul sound card yang dikenali oleh kernel,
sehingga pada saat booting dapat di-porting.
Dengan membuka Yast hardware informa-
tion, diketahui bahwa notebook ini meng-
gunakan driver module: snd_hda_intel.
Identitas modul driver sound card tersebut
diperlukan nanti pada saat akan mengedit
kernel pada konfigurasi sistem modem.

Kembali pada smartlink modem. Untuk
mendapatkan informasi tentang modemini,
ada cara yang paling efektif, yaitu informasi
dari software modem itu sendiri. Caranya
dengan membuka file software yang sudah
terinstalasi pada control center (Gambar 1).
Informasi dari softmodem/README.ALSA
menjelaskan bahwa softmodem ALSA men-
dukung driver modem “snd_hda_intel”.

Langkah selanjutnya adalah mengi-

kuti prosedur konfigurasi yang ditentukan.
Namun tidak sepenuhnya sesuai dengan
yang tertulis, karena ada hal-hal yang perlu
disesuaikan lagi. Oleh sebab itu perlu dilaku-
kan dengan cara yang lebih pasti, yakni de-
ngan mengedit file slmodemd. Ada bebera-
pa pilihan editor, seperti Vim (vi), pico, atau
KEdit. Penulis menggunakan Vim. Berikut
ini langkah-langkah editing slmodemd:

EDITING FILE SLMODEMD
1. File /etc/sysconfig/slmodemd

Buka file slmodemd pada root /etc/sys-
config/ dengan perintah vi slmodemd,
ganti SLMODEMD_COUNTRY dengan
“INDONESIA”, ganti SLMODEMD_
DEVICE dengan “modem:0”, dan SL-
MODEMD_USE_ALSA dengan ‘yes”,
seperti gambar berikut:

# Country, for which the modem
shall be configured for.

#

# A list of all supported
country names can be retrieved
# by calling “sTmodemd --
countrylist” from the shell
prompt.

#

SLMODEMD_COUNTRY="INDONESIA”

## Type:
## Default:
## ServiceRestart: slmodemd

#

# Hardware(not modem) device for
the slmodemd.

string
“modem:1”

SLMODEMD_DEVICE="modem:@”

## Type: yesno

ATI1: [Soft Modem, 2.9.10 Smart Link Ltd.

# KPPP Configuration - KPPP

Accounts | Modems |graph jrvusc I

ATI 4: (520=000 521=000 522=000 523=000
" ATIS: [Stored Profile 0: ] [Device | Modem

%/ Edit Modem: modem -

. ATIE: [Stored Profil 1: ™|
[madem ATI7: [Country: INDONESIA =

@ gose | H | =0

] Wait for dial tone before dialing

AENCTTC

Busy wait:

Modem yolume: — 7(‘)

% gl o

Gambar 2. Tes atau query modem melalui program kppp.

Modem Commands...
Query Modem, ]

[ Terminal...
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KSNAPSHOT:

4 Connecting to: telkomnet@instan =%

Dialing 080989993

» Login Script Debug Window

ATZ
oK

AT+GMM +GCl=54
SmartLink Soft Modem
0K

ATMILY
OK

ATX3
0K

ATDT080989999

[Expecting: CONNECT

ad < o = IHIENEREE -
Gambar 3. Kppp sedang melakukan dial-up.
## Default: “no”
## ServiceRestart: slmodemd
#
# If set to yes the Advanced
Linux Sound Architecture
subsystem is used
# to make your modem working.
This variable must be set to yes
if you
# are using an ATI IXP modem.
#
SLMODEM_USE_ALSA="yes”

Kemudian tutup dan simpan file terse-
but, langkah selanjutnya membuka file
/etc/sysconfig/kernel.

2. File /etc/sysconfig/kernel
Masih di root /etc/sysconfig lakukan ed-
iting terhadap kernel, pada baris MOD-
ULES_LOADED_ON_BOOT tambahkan
“snd_hda_intel”, seperti script berikut:

MODULES_LOADED_ON_BOOT="snd_hda_
intel”

CEIE]

Simpan dan keluar dari editor. Sekarang

lakukan perintah berikut “modprobe
snd_hda_intel”, diikuti Enter. Kemudian
ketikkan perintah “insserv slmodemd”.
Berikutnya masuk ke direktori /etc/init.
d/ untuk mengedit file silmodemd.

3. File /etc/init.d/slmodemd

Bukalah file slmodemd, kemudian gan-
tilah semua kata “slamr0” dengan “sl-
modemd”. Simpan dan keluar dari edi-
tor, kemudian ketikkan perintah “stat
slmodemd”, maka akan tampil informasi
perubahan slmodemd.

root:/etc/init.d # stat simodemd

File: “slmodemd’
Size: 2912 Blocks: 8 10
Block: 4096 regular file

Change: 2007-01-29
23:43:48.000000000 +0700

Untuk memastikan apakah sudah ber-
hasil melakukan editing, ketikkan perintah
berikut “slmodemd -a hw:0” maka akan
tampil seperti berikut:
root:/etc/init.d # simodemd -a
modem: @

## Type: string

SmartLink Soft Modem: version
2.9.10 Nov 29 2006 13:53:16

## Default: “»

symbolic 1link “/dev/ttySL@’> ->
“/dev/pts/3’ created.

modem “modem:@’ created. TTY is

“/dev/pts/3’
Use “/dev/ttySL@’ as modem device,
Ctr1+C for termination.

Agar modem dikenali sebagai /dev/mo-
dem, maka lakukan perintah In -sf untuk
membuat soft link secara paksa:

# In -sf /dev/ttySL@ /dev/modem
# In -sf /dev/ttySL@ /1ib/udev/
devices/modem.

Setelah di-reboot, cobalah setting dengan
perintah kppp& pada root. Penulis meng-
gunakan ISP telkomnet@instan. Untuk men-
getahui respon dari modem, coba klik tom-
bol Query Modem, kalau berhasil maka akan
tampil seperti Gambar 2. Sedangkan, catatan
koneksinya (Log) seperti Gambar 3. Setup in-
ternet juga dapat dilakukan melalui Yast.

KESIMPULAN

Dari proses penyelesaian masalah tersebut,
ternyata persoalannya terletak pada desain
program smart link soft modem itu sendiri.
Pada setiap ekstraksi paket modul, smart
link soft modem akan memerintahkan
pembentukan modules dengan nama slamr
dengan virtual device: /dev/slamr0. Padahal
notebook Acer 5583NWXMi menggunakan
chipset suara Intel (snd_hda_intel), yang
termasuk dalam dukungan ALSA. Sehingga,
ketika menggunakan driver modem ALSA,
tidak perlu me-load modules slamr. Karena
dalam hal ini driver modem ALSA hanya
mengenal slmodemd dengan virtual device:
/dev/slmodemd.

Sayangnya, hal tersebut tidak terjadi se-
cara otomatis, jadi harus dilakukan secara
manual. Oleh sebab itu, tanpa editing file
/etc/init.d/slmodemd, maka setting mo-
dem akan gagal. Karena meskipun sudah
dilakukan perubahan data pada /etc/sys-
config/slmodemd dan /etc/sysconfig/ker-
nel, ternyata status data tidak mengalami
perubahan otomatis pada file /etc/init.
d/slmodemd.

Adanya perubahan identifikasi pada
sistem modules kernel, menyebabkan set-
ting modem tidak langsung dapat dikenali,
sehingga perlu load module secara manual
atau lakukan reboot ulang. Tujuan reboot
juga untuk menguji apakah modul kernel
yang baru dapat dikenali saat booting.

Tjokorda Bagus Putra M. [tjok_bpm@yahoo.co.id]
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i sistem proprietary, di mana source code suatu program merupakan rahasia besar

developer dan file binary adalah yang digunakan oleh user, tidak jarang user mengedit

file binary tersebut untuk melakukan berbagai perubahan sederhana, seperti

mengganti tulisan start pada taskbar Windows dengan tulisan mulai. Bukan tindakan

yang legal, namun cukup menarik.

Di Linux, di mana sebagian besar program
dilisensikan di bawah lisensi free software/
open source, mengubah tulisan tertentu dari
interface program bukanlah masalah besar.
Tentu saja, kita tinggal mengambil source
code program tersebut, melakukan modi-
fikasi bagian yang diinginkan, melakukan
kompilasi, dan kita akan mendapatkan apa
yang kita inginkan.

Walaupun, melakukan pengeditan
file binary itu sendiri, terlepas dari keter-
sediaan source code, tetap merupakan hal
yang menarik. Dan, terkadang, barang-
kali, kita ingin melakukan sedikit peruba-
han tulisan, namun tidak memiliki source
code program tersebut atau tidak memiliki
semua paket yang dibutuhkan untuk kom-
pilasi, atau merasa bahwa kita hanya ingin
mengubah sedikit saja bagian program dan
malas melakukan kompilasi. Apapun ala-
san Anda.

Di tulisan ini, kita akan membahas cara
mengubah tulisan tertentu pada user inter-
face beberapa contoh program. Penguba-
han file binary bisa saja menjadi sangat
kompleks dengan hasil akhir yang sangat
signifikan. Apa kita bahas di sini hany-
alah merupakan contoh sederhana. Dan
sebagai catatan, apa yang dilakukan di sini
hanyalah merupakan contoh dan bukan-
nya merupakan ajakan untuk mengedit
berbagai binary (termasuk yang melanggar
lisensi) untuk kepentingan yang ilegal.

Tulisan ini dan semua contoh yang ada
dibuat di sistem Zenwalk Linux 4.2, namun
seharusnya dapat diterapkan pada sistem
lain tanpa masalah sama sekali.

Ghex, senjata ampuh kita
Pertama-tama, sebelum melakukan peng-
editan, kita membutuhkan editor file binary
yang nyaman digunakan. Sebagai contoh,
penulis menggunakan Ghex versi 2.8.2.

Carilah Ghex di dalam instalasi atau me-
dia distribusi sistem Anda. Ghex dipaketkan
di dalam cukup banyak distribusi Linux.
Apabila tidak ditemukan, carilah paket un-
tuk distribusi Anda di Internet atau komu-
nitas lokal Anda. Apabila tidak ditemukan
juga, download-lah source code Ghex di
http://pluton.ijs.si/~jaka/soft. htmI#GHEX
dan lakukanlah kompilasi sendiri.

Setelah Ghex terinstal, jalankanlah Ghex
dengan perintah:
$ ghex2

Apabila Ghex dapat dijalankan, maka
kita pun siap untuk memulai.

Contoh pertama: Is

Sebagai contoh pertama, kita akan mencoba

mengubah teks tertentu pada program Is.

Kopikanlah program ls yang ada di /bin ke di-

rektori percobaan Anda, misal di /tmp/HEX/.
Pastikan program ls yang di-copy-kan

tersebut bisa dijalankan:

$ ./1s --version
1s (GNU coreutils) 5.97
Copyright (C) 2006 Free Software
Foundation, Inc.
This is free software.

You may
redistribute copies of it under
the terms of

the GNU General Public License
<http://www.gnu.org/licenses/gpl.
html>.

There is NO WARRANTY, to the
extent permitted by law.

Written by Richard Stallman and
David MacKenzie.

Sebagai contoh pertama, kita akan
mengganti tulisan versi 5.97 tersebut men-
jadi versi 9.99.

Lakukanlah langkah-langkah berikut ini:
® Jalankan Ghex.
® Bukalah program ls yang kita copy ter-

sebut dengan mengakses menu File ->

Open.
® Di bagian panel kanan, scrol-lah ke bagi-

an agak bawah di mana kita bisa mene-
mukan tulisan versi 5.97 yang ingin
kita ganti. Di sistem penulis, tulisan ini
ditemukan pada offset D22D. Cara yang
lebih mudah apabila kita mengetahui
offsetnya adalah dengan mengakses
menu Edit -> Goto Byte... dan memasuk-
kan nilai 0xD22D.
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® Gantilah tulisan 5.97 dengan 9.99.

® Simpanlah dengan mengakses menu File
-> Save.

® Keluarlah dari program dengan meng-
akses File -> Exit.

Cobalah kembali menjalankan program
ls kita tersebut:
$ ./1s --version

Kopikanlah program mc yang ada di /
usr/bin ke direktori percobaan Anda, misal
di /tmp/HEX/.

Pastikan program mc yang di-copy-kan
tersebut bisa dijalankan:
$ ./mc --version
GNU Midnight Commander 4.6.1
Virtual File System: tarfs, extfs,
cpiofs, ftpfs, fish, undelfs

1s (GNU coreutils) 9.99

With builtin Editor

Copyright (C) 2006 Free Software
Foundation, Inc.

Using system-installed S-Lang
library with terminfo database

This is free software. You may
redistribute copies of it under

the terms of

With subshell support as default
With support for background
operations

the GNU General Public License
<http://www.gnu.org/licenses/gpl.
html>.

With mouse support on xterm and
Linux console
With internationalization support

There is NO WARRANTY, to the
extent permitted by law.

Written by Richard Stallman and
David MacKenzie.

Kini, versi Is kita adalah 9.99.

Ukuran program ls yang sesungguhnya
dan program ls yang telah dimodifikasi tetap
sama. Namun sesungguhnya, md5sum ke-
dua program tersebut berbeda karena me-
mang ada informasi yang berbeda:
$ md5sum /bin/Ts 1s
c205a9714@d3e@c85cPe76bbe7749076
/bin/1s
3c5633fd@29bcaf8811b94e2945b4497 1s

MC: command menjadi perintah
Pada contoh kedua ini, kita akan mengubah
tulisan Command pada bar bagian atas mc
menjadi tulisan Perintah.

With multiple codepages support

Lakukanlah langkah-langkah berikut ini:

® Jalankan Ghex.

® Bukalah program mc yang kita copy
tersebut dengan mengakses menu File ->
Open.

® Di bagian panel kanan, scroll-lah ke ba-
gian agak bawah di mana kita bisa me-
nemukan tulisan Command yang ingin
kita ganti. Tulisan Command berada di
sekitar &File . &Command . &Options
.[Options Menu]. .Di sistem penulis,
tulisan Command ini ditemukan pada
offset 6E916.

® Gantilah tulisan Command menjadi Perin-
tah. Harap diperhatikan bahwa Command
hanya terdiri dari 7 karakter sementara
Perintah terdiri dari 8 karakter. Karakter
terakhir kita ketikkan begitu saja sebagai
kelanjutan dari karakter sebelumnya.

® Simpanlah dengan mengakses menu File
-> Save.

® Keluarlah dari program dengan meng-
akses File -> Exit.

Cobalah kembali menjalankan program
mc kita tersebut.

Mengedit dan menembus batas

Pada contoh sebelumnya (mc), kita melihat
bahwa kita mengganti tulisan yang terdiri
dari 7 karakter dengan tulisan yang terdiri
dari 8 karakter. Ketika kita mengedit file
binary, maka alangkah baiknya kita tidak
melakukan tindakan yang berbahaya seperti
ini, kecuali kita tahu persis apa yang sedang
kita lakukan, karena berbeda program
mungkin saja berbeda tingkah laku ketika
tindakan seperti ini dilakukan.

Khusus untuk program mc tadi, setelah
penulis mencoba-coba, kita sebenarnya masih
bisa mengganti sampai 10 karakter (aslinya: 7
karakter) dengan resiko minimal. Sebagai con-
toh, kita bisa mengganti tulisan Command
menjadi Perintahku. Namun, dalam melaku-
kan penggantian, offset penggantian tidaklah
sama dengan offset tulisan Command. Kita
mulai mengganti dari 2 offset sebelumnya.

Apakah yang terjadi kalau kita mengganti
sampai lebih dari 10 karakter? Di mc penulis,
menu akan tampil kacau, dimana tulisan yang
kita buat akan digabung dengan Options, wa-
laupun Options akan ditampilkan lagi di sebe-
lah kanannya. Cobalah bereksperimen.

Susahnya menemukan!
Dalam pekerjaan sederhana mengedit file
binary seperti mengganti teks, tentunya

kita perlu mengetahui di offset mana teks

0 Is - GHex
Ele Edt View Windows Help

cEx [s
Ele Edt View Windows Help

me - GHex TEX

[TF 45 4C 46 01 61 61 00 60 00 00 60 00 00 60 00 02 60 03 60 01 00 00 00
10 97 04 08 34 00 00 00 DC 16 01 00 00 00 00 00 34 00 20 00 08 00 28 00
1B 00 1A 00 06 00 00 060 34 00 00 00 34 80 064 08 34 80 04 08 00 01 00 00
00 61 00 60 05 00 60 00 ©4 00 00 60 03 60 00 00 34 01 60 00 34 81 04 08
34 81 64 08 13 00 00 60 13 00 00 00 64 6O 60 00 ©1 00 00 60 01 00 00 00
00 60 00 00 00 80 04 08 00 80 04 08 CO 09 O1 00 CO 09 01 00 05 00 00 0O
00 10 00 00 61 00 60 60 00 16 01 00 60 90 05 68 00 906 65 08 6C 63 00 00
BO 067 00 00 06 00 60 00 00 10 00 00 02 00 00 00 14 10 01 00 14 90 05 08
14 90 65 08 DO 00 00 660 DO 66 00 60 06 6O 60 00 ©4 00 00 00 04 00 00 00
/48 61 00 60 48 81 64 08 48 81 04 08 20 60 0O 00 26 00 060 00 04 00 00 0O
04 60 00 00 56 ES5 74 64 F8 08 01 00 F8 88 05 08 F8 88 065 08 2C 00 00 60
2C 60 00 00 04 00 00 00 04 00 00 00 51 E5 74 64 00 00 00 00 00 00 00 0O
100 60 00 00 0O 00 00 0O 00 0O 00 00 06 00 00 00 04 00 00 00 2F 6C 69 62
2F 6C 64 2D 6C 69 6E 75 78 2E 73 6F 2E 32 00 00 04 00 00 00 10 60 00 0O
01 60 00 00 47 4E 55 00 00 00 00 06 02 60 00 00 04 00 60 00 ©1 00 00 0O
/43 60 00 00 5C 00 60 0O 60 0O 00 60 56 60 0O 00 08 00 00 00 45 00 00 00
06 60 00 00 5B 00 00 00 23 00 00 00 3A 00 00 60 19 00 00 00 18 00 00 00
00 60 00 00 48 00 60 00 55 00 00 00 3E 00 00 00 59 00 00 00 2D 00 00 00
2E 00 00 00 35 00 00 00 4B 00 00 00 46 00 00 00 2C 00 00 00 4E 00 00 00
58 00 060 00 42 00 00 60 OC 66 00 60 14 6O 60 00 2B 00 60 00 6O 60 00 00
32 00 60 00 1B 00 00 60 54 06 00 60 29 0O 60 00 00 00 00 00 1A 00 00 00
03 60 00 00 5A 00 60 00 00 00 00 00 00 60 00 00 16 00 060 00 52 00 00 00
00 60 00 00 0O 00 00 00 OD 00 00 00 41 00 00 60 00 00 00 00 4A 00 00 00

00 00 N0 A0 NA NA_0A QA 21 A AA 0N AA_AA_NA_AA_AA_NA_AQ DA 52 QA OA_A0

[TF 45 4C 46 01 61 61 00 66 00 00 60 00 00 60 00 02 60 03 60 01 00 00 00
00 C8 04 08 34 00 00 00 E8 A3 07 00 00 00 00 00 34 00 20 00 08 00 28 00
1B 00 1A 00 06 00 00 060 34 00 00 00 34 80 064 08 34 80 04 08 00 01 00 00
00 61 00 60 05 60 60 00 64 00 00 00 63 60 00 00 34 01 00 00 34 81 04 08
34 81 64 08 13 00 00 60 13 00 00 00 64 6O 60 00 ©1 00 60 60 01 00 00 00
00 60 00 00 00 80 04 08 00 80 04 08 A4 71 07 00 A4 71 07 00 05 00 00 00
00 10 00 00 01 00 60 60 A4 71 07 00 A4 O1 OC 68 A4 01 6C 08 18 2B 00 00
A4 75 01 00 06 00 00 60 00 16 00 00 62 00 060 00 B8 71 07 00 B8 01 OC 08
B8 61 OC 068 F8 00 60 00 F8 0O 00 00 06 060 0O 00 04 00 00 0O ©4 00 00 0O
/48 61 00 60 48 81 64 08 48 81 04 08 20 60 0O 00 20 00 60 00 04 00 00 6O
04 60 00 00 56 ES5 74 64 54 71 07 060 54 F1 0B 08 54 F1 6B 08 14 00 00 00
14 00 00 00 04 0O 00 00 04 00 00 00 51 ES 74 64 00 00 00 00 00 00 00 00
100 60 00 00 0O 00 00 0O 00 00 00 00 06 00 00 00 04 00 00 00 2F 6C 69 62
2F 6C 64 2D 6C 69 6E 75 78 2E 73 6F 2E 32 00 00 04 00 00 00 10 60 00 0O
01 60 00 00 47 4E 55 00 00 00 00 06 02 60 00 00 04 00 60 00 ©1 60 00 00
067 01 66 00 32 01 00 660 DO 60 00 60 1B 0O 60 00 5B 00 00 00 68 00 00 00
00 60 00 00 0O 00 00 60 AC 00 00 00 00 00 00 60 00 00 00 00 A7 00 00 00
A6 00 00 00 C5 00 00 60 2A 01 00 00 71 00 00 00 00 00 00 00 F3 00 00 00
00 60 00 00 00 00 00 00 79 00 00 00 19 1 00 00 F1 00 00 00 19 00 00 00|
00 60 00 00 E7 00 060 0O 48 00 00 00 27 00 00 00 2F 01 00 0O 00 00 00 0O
100 60 00 60 00 00 60 00 BD 00 00 00 0O 60 0O 00 00 00 060 00 F7 00 00 00
€2 00 60 00 90 00 00 60 0O 00 00 00 00 6O 00 00 00 00 00 00 00 00 00 00
2B 01 00 00 00 00 00 00 28 01 00 00 00 00 00 00 00 01 00 00 FF 00 00 00|  |+..

7 00 0n oo A4 0n 00 AA 14 01 0D NN SE AA_NA_AA 72 0O AQ DA _OA_AQ_AA_A0

Signed 8 bit 127 Signed 32 bit 1179403647 | Hexadecimal 7 Signed 8 bit 127 Signed 32 bit 1179403647 ] Hexadecimal G
Unsigned 8 bit 127 | unsigned 32 bit 1179403647 | octal 177 Unsigned 8 bit 127 | unsigned 32 bit 1179403647 | octal 177
Signed 16 bit 17791 | 32 bt foat 13073370404 | sinary: o111 Signed 16 bit 17791 | 32 bit float 13073370404 | sinary: o111
Unsigned 16 bit: 17791 64 bit float 1.396131e-309 | stream Length: 8 Unsigned 16 bit: 17791 64 bit float 1.396131e-309 | stream Length: 8

) Show lttle endian decoding Show unsigned and float as hexadecimal ) Show lttle endian decoding Show unsigned and float as hexadecimal

[offset. 0 [offset. 0

Ghex membuka program Is. Ghex membuka program me.
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yang ingin kita ganti. Kalau teks tersebut
cukup unik, seperti versi program, maka hal
ini tidaklah menjadi masalah. Namun, kalau
kita ingin mengganti teks yang cukup umum
ditemukan di user interface program, maka kita
perlu sedikit usaha untuk mencari.

Membuat pengeditan lebih susah
Bagi developer yang ingin menjadikan binary
programnya lebih susah diedit, maka alat ban-
tu packer seperti UPX cukup dapat diandalkan.
Sedianya, UPX akan mengompres file execut-
able menjadi lebih kecil. Tapi, sebagai kon-
sekuensi dari proses kompresi, string yang
terdapat di dalam suatu executable menjadi
jauh lebih susah untuk ditemukan, dan kare-
nanya menjadi lebih susah untuk diedit.

UPX bisa di-download di http://upx.source-
forge.net dan telah disertakan ke dalam ber-
bagai distribusi popular. Carilah ke dalam
media distribusi Anda sebelum men-down-
load dan melakukan kompilasi sendiri.

Sebagai contoh, penulis akan melakukan
kompresi pada file executable mc, yang su-
dah dimodifikasi sebelumnya.
$ upx mc

mal dan ASCII dari file binary kita, program
hexdump dapat sangat diandalkan. Program
hexdump merupakan anggota paket util-
linux dan harusnya dapat ditemukan pada
hampir semua distribusi Linux.

Berikut ini contoh dump heksadesimal
file executable mc kita:
$ hexdump mc|head -n 10
p00000e 457f 464c 0101 9001 694c
756e 0078 9909
pooo10 00092 0003 0001 9900 Sb2c
p@c3 0034 9999
p000020 0000 0000 0000 9000 0034
p020 0002 9999
p000030 0000 0000 0001 9000 0000
p000 1000 99cl

g0000080 00 80 04 08 ad 71 07
g0 ad 71 07 00 05 00 00 00
|....8q..89q...... |

g0000e099 00 10 00 00 01 00 00
g0 a4 71 07 00 a4 @1 Bc 08

Kita bisa pula mencari teks dengan ban-
tuan program grep. Sebagai contoh, kita
akan mencari tulisan midnight:
$ hexdump -C mc| grep -i
‘midnight’

Po06cAAD 20 74 68 65 20 4d 69
64 6e 69 67 68 74 20 43 6f | the
Midnight Col

P000040 1000 0@cd 52ad 8003 52a0
@093 0085 0009
g000050 1000 0000 0001 0000 @748
@098 7748 080d
g000060 7748 080d 000F 0000 B000
g000 0000 0009

g006d360 73 74 00 4d 69 64 6e

69 67 68 74 20 43 6f 6d 6d |st.
Midnight Comm]|

p006e8dd 31 30 00 20 54 68 65 20
4d 69 64 6e 69 67 68 74 |10. The
Midnight|

g000070 1000 0090 7f28 63d2 5055
2158 @772 Bchd
g000080 3f77 7b97 a820 8007 a820
@007 0134 0009

Ultimate
Packer for eXecutables

g000090 B%a7 0000 0002 0000 3f63
964 457f 464c

0006e97@ 55 20 4d 69 64 6e 69

67 68 74 20 43 6f 6d 6d 61 |U
Midnight Comma|

go06ecl® 74 68 65 20 4d 69 64

6e 69 67 68 74 20 43 6f 6d |the
Midnight Com]|

Copyright (C) 1996,1997,1998,
1999,2000,2001,2002,2003,2004,200
5,2006
UPX 2.02 Markus Oberhumer,
Laszlo Molnar & John Reiser  Aug
13th 2006

Dan, berikut ini adalah bentuk canonical
heksadesimal dan ASCII:
$ hexdump -C mc|head -n 10
pEoooeee 7f 45 4c 46 01 01 01
po 00 00 00 00 00 00 00 00

File size

Format Name

501792 ->
Tinux/e1f386 mc

217796

43.40%

Packed 1 file.

00000010 02 00 03 08 01 00 00
00 00 c8 04 08 34 08 00 00
e E..4...]

00000020 e8 a3 07 00 00 00 00
00 34 00 20 00 08 00 28 00
[8f......4. ...(.I

00000630 1b 00 la 08 06 00 00
00 34 00 00 00 34 80 04 08
e 4...4...]

Ketika file tersebut dibuka kembali dengan
ghex, kita tidak bisa menemukan lagi hasil
modifikasi kita ataupun teks panjang lainnya,

yang sebelum dikompres bisa kita temukan.

Sudah kecil, susah diedit pula. Seru bukan?

Hexdump: tool berguna lainnya

Tool editor seperti ghex memang berguna
untuk mengedit file binary. Namun, kalau
kita hanya ingin melihat dump heksadesi-

p0000048 34 80 04 08 00 01 09
g0 00 91 00 09 95 00 09 00

g0000050 04 00 00 00 33 00 09
g8 34 91 00 09 34 81 @4 08

p0000068 34 81 64 08 13 00 09
g8 13 00 00 00 04 00 00 00

go0e0a78 01 00 00 00 91 60 09
g0 00 90 00 00 00 80 84 08

goo6flad 20 54 68 65 20 4d 69

64 6e 69 67 68 74 20 43 6f | The
Midnight Col

g0071030 2e Oa 00 00 47 4e 55 20
4d 69 64 6e 69 67 68 74 ..GNU
Midnight|

@00715c@ 69 72 73 00 4d 69 64

6e 69 67 68 74 20 43 6f 6d |irs.
Midnight Com]|

g00718ed 4d 69 64 6e 69 67 68

74 2d 43 6f 6d 6d 61 6e 64
[Midnight-Command]|

g007527¢ 4d 69 64 6e 69 67 68 74
20 43 6f 6d 6d 61 6e 64 [Midnight
Command |

Sediakan selalu back-up

Apa yang kita lakukan di sini merupakan
tindakan yang cukup berbahaya. Apabila
kita salah mengubah, maka program bisa
tidak dapat bekerja. Sediakanlah selalu back-
up sebelum melakukan modifikasi.

Sampai di sini dulu pembahasan kita.
Pengeditan file binary bisa sangat berguna
selama kita melakukannya dengan benar.
Selamat mencobal &

Noprianto [noprianto@infolinux.co.id
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lackware merupakan salah satu distribusi Linux tertua yang masih di-maintain dengan

baik. Slackware juga merupakan distribusi Linux yang stabil dan dirancang dengan

sangat hati-hati. Bagi Anda yang senang menggunakan Slackware ataupun ingin

memaketkan aplikasi Anda untuk pengguna Slackware, kita akan membahas cara cepat

dan mudah membangun paket.

Untuk membangun paket Slackware, kita bisa
menggunakan berbagai cara yang kita sukai.
Hal ini disebabkan karena paket Slackware
sendiri, dibandingkan paket RPM ataupun
DEB, jauh lebih sederhana dan mudah diba-
ngun. Paket Slackware sendiri merupakan file
tar.gz biasa (dengan ekstensi .tgz) yang dileng-
kapi dengan informasi dan script opsional.
Kita bisa membangun paket Slackware
dengan cara manual memanfaatkan tool-tool
standar, tar dan gzip. Kita juga bisa meng-
gunakan berbagai tool yang datang dengan
distribusi Slackware dan memang dikhusus-
kan untuk pembuatan paket. Apabila diperlu-
kan, kita juga bisa memanfaatkan/mencontoh
berbagai slackbuild script yang tersedia. Dan,
kalaupun ingin lebih canggih, kita bisa meng-
gunakan bantuan tool pihak ketiga seperti:
® checkinstall.
® installwatch.
® protopkg.

Untuk mendapatkan paket Slackware, kita
pun bisa mengonversi paket RPM menjadi pa-
ket Slackware dengan bantuan tool:
® pm2tgz.
® alien.

Di dalam tulisan ini, kita tidak akan meng-
gunakan konversi paket ataupun tool-tool
pihak ketiga seperti disebutkan. Kita juga
tentu saja tidak akan membangunnya secara
manual (tar, gzip manual). Untuk kesempatan

kali ini, kita akan membangun menggunakan
tool standar makepkg.

Semua contoh tulisan ini dibangun di atas
sistem Zenwalk Linux 4.2, namun seharusnya
dapat diterapkan pada sistem Slackware dan
berbagai turunannya, tanpa atau dengan se-
dikit penyesuaian.

Sebagai catatan, cara yang digunakan di
dalam pembahasan ini merupakan cara yang
sederhana dan terdapat kemungkinan tidak
berlaku untuk semua program. Untuk metode
yang lebih baik, Anda bisa mempergunakan
bantuan program checkinstall (akan dibahas
di tulisan lain).

Langkah 1: Siapkan program

Sebagai langkah pertama, siapkanlah program
yang ingin dipaketkan. Penulis akan meng-
asumsikan Anda melakukan kompilasi sendiri
dari source code. Contoh paket yang akan pe-
nulis bangun adalah moc, sebuah audio player
powerful yang berjalan di console.

Lakukanlah kompilasi seperti biasa, tapi
dengan sebelumnya mengarahkan prefix ke
suatu direktori khusus. Sebagai contoh, siap-
kan sebuah direktori khusus /tmp/program.

Semua aplikasi dikompilasi dengan prefix
/tmp/program/<NAMA_APP>. Apabila kita
membangun aplikasi moc, maka prefix untuk
moc akan diset ke /tmp/program/moc. Cara
kompilasi tidak dibahas di dalam tulisan ini.
Rujuklah ke dokumentasi kompilasi source
code program.

Setelah dikompilasi dan diinstal, semua
file-file yang dibutuhkan akan berada di dalam
/tmp/program/moc. Contoh isi direktori moc
penulis:
$ find

./bin

./bin/mocp

./1ib

./1ib/moc
./1ib/moc/decoder_plugins
./1ib/moc/decoder_plugins/
1ibmusepack_decoder.la
./1ib/moc/decoder_plugins/
1ibmusepack_decoder.so
./1ib/moc/decoder_plugins/1ibvorbis_
decoder.la
./1ib/moc/decoder_plugins/1ibvorbis_
decoder.so
./1ib/moc/decoder_plugins/1ibflac_
decoder.la
./1ib/moc/decoder_plugins/1ibflac_
decoder.so
./1ib/moc/decoder_plugins/Tibmp3_
decoder.la
./1ib/moc/decoder_plugins/Tibmp3_
decoder.so

./share

./share/doc

./share/doc/moc
./share/doc/moc/keymap.example
./share/doc/moc/README
./share/doc/moc/THANKS
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./share/doc/moc/config.example

<NAMA_APP>: <DESKRIPSI LEBIH LANJUT>

./share/man

<NAMA_APP>: <DESKRIPSI LEBIH LANJUT>

directory ownerships to root.root
([yles, [n]o)?

./share/man/manl <NAMA_APP>: <BARIS KOSONG>
./share/man/manl/mocp.1

./share/moc Contoh isi install/slack-desc untuk paket
./share/moc/themes moc:

./share/moc/themes/example_theme
./share/moc/themes/yellow_red_theme

moc: moc version 2.4.1, console
audio player for LINUX/UNIX

./share/moc/themes/black_theme

moc:

./share/moc/themes/red_theme

moc: moc features:

./share/moc/themes/green_theme

moc: - simple mixer

Sampai di pertanyaan ini, jawablah yes
untuk me-reset semua hak akses direktori ke
755, dengan kepemilikan pada user root.root.
Ini merupakan kondisi standar. Apabila Anda
memang mengatur hak akses dan kepemilikan
secara khusus, jangan jawab yes di sini.
Creating tar file moc-2.4.1-1586-
nopl.tar...

./share/moc/themes/moca_theme

moc: - color themes

./share/moc/themes/nightly_theme moc: - searching support ./
./share/moc/themes/transparent- moc: - configurable title creation usr/
background from tags usr/bin/
./share/moc/themes/darkdot_theme moc: - optional character set usr/bin/mocp
conversion for file tags usr/1ib/

Langkah 2: Buat struktur direktori isi
paket

Anda telah memiliki sebuah tree direktori
aplikasi di /tmp/program/<NAMA_APP>, se-
bagai contoh: /tmp/program/moc.

Di tahap ini, kita akan membangun struk-
tur direktori baru untuk persiapan pembuat-
an paket. Buatlah direktori khusus /tmp/
package/<NAMA_APP>.
membuat direktori /tmp/package/moc.

Contoh, penulis

Di dalam /tmp/package/moc, penulis se-
lanjutnya mempersiapkan prefix sesungguh-
nya untuk sistem target. Apabila moc ingin
diinstal di /usr, maka kita akan membuat di-
rektori usr di dalam /tmp/package/moc.

Selanjutnya, copy-kanlah semua file pro-
gram ke dalam /tmp/package/<NAMA_
APP>/<PREFIX_TARGET>. Sebagai contoh,
kopikanlah semua isi /tmp/program/moc/ ke
/tmp/package/moc/ust/:
$ cd /tmp/package/moc/usr/

moc: - 0SS, ALSA and JACK output

usr/1ib/moc/

moc: - user defined key

moc:

Langkah 4: Bangun paket
Kita sampai di langkah terakhir. Aktiflah di di-
rektori/tmp/package/<NAMA_APP>, sebagai
contoh /tmp/package/moc.

Login-lah sebagai root dan berikanlah pat-
tern perintah berikut ini:
# makepkg <NAMA_APP>-<VERSI>-<ARCH>-
<REV>.tgz

install/slack-desc
tar-1.13: moc-2.4.1-1586-nopl.tar
is the archive; not dumped

Gzipping moc-2.4.1-i586-nopl.tar...

Renaming moc-2.4.1-i586-nopl.tar.gz
to moc-2.4.1-1586-nopl.tgz...

Sebagai contoh:
# makepkg moc-2.4.1-i586-nopl.tgz

Slackware package maker, version
2.1.

Searching for symbolic links:

$ cp -a /tmp/program/moc/* .

Langkah 3: Buat deskripsi paket

Masth di /tmp/package/<NAMA_APP>, buat-
lah direktori install.

$ mkdir install

No symbolic Tinks were found, so we
won’t make an installation script.
You can make your own later in ./
install/doinst.sh and rebuild the
package if you Tike.

Kemudian, buatlah file install/slack-desc
dengan pattern isi sebagai berikut:

This next step is optional - you
can set the directories in your
package

<NAMA_APP>: <DESKRIPSI SINGKAT> to some sane permissions. If any of
<NAMA_APP>: <BARIS KOSONG> the directories in your package have
<NAMA_APP>: <DESKRIPSI LEBIH LANJUT> | special permissions, then DO NOT
<NAMA_APP>: <DESKRIPSI LEBIH LANJUT> | reset them here!

<NAMA_APP>: <DESKRIPSI LEBIH LANJUT>

<NAMA_APP>: <DESKRIPSI LEBIH LANJUT> Would you Tike to reset all
<NAMA_APP>: <DESKRIPSI LEBIH LANJUT> directory permissions to 755 (drwxr-
<NAMA_APP>: <DESKRIPSI LEBIH LANJUT> | xr-x) and

Package creation complete.

Selesai sudah. Kini, kita memiliki file paket
yang diinginkan di direktori aktif, sesuai nama
yang kita berikan. Kita bisa menginstal paket
tersebut dengan perintah installpkg.

Seperti telah disebutkan sebelumnya,
cara seperti ini tidak selalu berlaku un-
tuk semua program. Terutama apabila
program hasil kompilasi memaksa untuk
membuka file tertentu sesuai prefix insta-
lasi. Atau, program/pustaka yang datang
dengan X-config, di mana X merupakan
nama program/pustaka, yang ketika di-
jalankan akan memberikan informasi
termasuk prefix. Namun, cara seperti ini
sangat membantu apabila kita ingin mem-
bangun paket Slackware dengan cepat dan
mudah.

Di kesempatan lainnya, kita akan mem-
bahas cara membangun paket Slackware
yang lebih canggih dan benar, dengan ban-
tuan checkinstall. Selamat mencobal Sam-
pai jumpa di kesempatan berikutnya. A

Noprianto [noprianto@infolinux.co.id

www.infolinux.web.id

INFOLINUX = 04/2007 71




TUTORIAL 201211

Kalau dipikir-pikir, penulis cukup beruntung

memiliki adapter wlan 802.11/g tanpa merk

jelas ini. Kebetulan bisa didapat dengan harga

relatif murah, bisa digunakan di Windows

dan di Linux pula. Bahkan, di Linux, kita bisa

mempergunakan tiga driver:

® Driver Windows (bawaan produsen)
menggunakan ndiswrapper (telah dibahas
sebelumnya), atau

® Driver bawaan produsen/Vendor Driver
(terdapat di CDROM driver ataupun versi
update), atau

® Driver pengembangan lebih lanjut oleh ko-

munitas/Vendor Based Driver.

Semua dari driver tersebut bisa bekerja
dengan baik. Instalasi Driver Windows meng-
gunakan ndiswrapper telah dibahas sebelum-
nya. Kini, kita akan membahas instalasi dua
driver lainnya.

Semua pembahasan di dalam tulisan ini
dibangun di atas sistem Debian GNU Linux
3.1 kernel default (dan juga bekerja dengan
baik di Zenwalk Linux 4.2), dengan kernel
source terinstal dan terkonfigur dan paket
lain untuk kompilasi juga telah terinstal. Peng-
guna distro lain harusnya dapat mengikuti
tanpa masalah berarti.

Driver dari komunitas/vendorbased

Driver untuk komunitas bisa di-download di

http://zd1211.ath.cx. Lakukanlah langkah-

langkah berikut setelah mendownload driver.

® Lihatlah ID device. Tancapkanlah device
dan berikan perintah berikut:

$ Tsusb

alam kesempatan yang lalu, penulis pernah membahas penggunaan ndiswrapper untuk
instalasi USB wireless LAN adapter chipset zd1211, menggunakan driver Windows.
Sebenarnya, chipset ini telah didukung oleh Linux. Tulisan ini akan membahas instalasi

dua driver yang tersedia di pasaran agar dapat berjalan di Linux.

$ make

Bus 004 Device 0@2: ID 1582:6003

/1ib/modules/2.6.8-2-386/build

Bus 0@4 Device 001: ID 0000:0000

/root/ZD1211BU/zd1211-driver-r83

Bus 0@3 Device 001: ID 0000:0000
Bus 0@2 Device 001: ID 0000:0000
Bus @@1 Device 0@1: ID 0000:0000

Catatlah ID device (dalam hal ini:
1582:6003) dan cocokkan ke http://
zd1211.ath.cx. Dalam melakukan pen-
cocokan, tidak masalah merk di website
tersebut berbeda dengan yang Anda
gunakan. Yang penting, patokannya
adalah ID device. Pastikan Anda me-
ngetahui apakah Anda harus mengisikan
1 atau O untuk variabel ZD1211REV_B
(di Makefile; dibahas nanti). Device yang
penulis gunakan, sesuai URL tersebut,
menggunakan zd1211b sehingga penulis
harus mengisikan 1 pada saat kompilasi
(dibahas nanti).

Ekstra arsip driver dan masuk ke direktori
hasil ekstrak:

$ tar zxvf zd1211-driver-r83.tgz

-1/root/ZD1211BU/zd1211-
driver-r83/src/include -
fomit-frame-pointer -02 -Wall
-Wstrict-prototypes -pipe
-DZDCONF_WE_STAT_SUPPORT=1 -
DHOST_IF_USB -DAMAC -DGCCK -DOFDM
-DHOSTAPD_SUPPORT -DUSE_EP4_SET_
REG -DDOWNLOADFIRMWARE -DfTX_
GAIN_OFDM=§ -DfNEW_CODE_MAP=1
-DfWRITE_WORD_REG=1 -DfREAD_MUL_
REG=1 -DENHANCE_ RX=1 -DZD1211B

CC [M] /root/ZD1211BU/zd1211-
driver-r83/src/zd1211.0

LD [M] /root/ZD1211BU/zd1211-
driver-r83/zd1211b.o

Building modules, stage 2.

MODPOST

cc /root/ZD1211BU/zd1211-
driver-r83/zd1211b.mod.o

$ cd zd1211-driver-r83

LD [M] /root/ZD1211BU/zd1211-
driver-r83/zd1211b.ko

Pengeditan variabel ZD1211REV_B di
Makefile. Bukalah Makefille dengan edi-
tor favorit Anda. Isikanlah dengan angka
0 ataupun 1 sesuai dengan informasi yang
telah Anda miliki.

Lakukan kompilasi dengan memberikan
perintah (warning tidak ditampilkan pada
output perintah berikut):

make[1]: Leaving directory “/usr/
src/kernel-headers-2.6.8-2-386’

Setelah kompilasi selesai, sebuah module
dengan nama zd1211b.ko (atau zd1211.
ko) akan terbentuk.

Lakukanlah instalasi dengan memberikan
perintah:

# make install
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/1ib/modules/2.6.8-2-386/build
/root/ZD1211BU/zd1211-driver-r83
-1/root/ZD1211BU/zd1211-
driver-r83/src/include -
fomit-frame-pointer -02 -Wall
-Wstrict-prototypes -pipe
-DZDCONF_WE_STAT_SUPPORT=1 -
DHOST_IF_USB -DAMAC -DGCCK -DOFDM
-DHOSTAPD_SUPPORT -DUSE_EP4_SET_
REG -DDOWNLOADFIRMWARE -DfTX_
GAIN_OFDM=§ -DfNEW_CODE_MAP=1
-DfWRITE_WORD_REG=1 -DfREAD_MUL_
REG=1 -DENHANCE_RX=1 -DZD1211B

na versinya terlalu kuno (2.2.0.0), penu-
lis men-download versi yang lebih baru
(2.16.0.0) dari http://zd1211.ath.cx atau
www.deine-taler.de/zd1211/. Download-lah
juga firmware (penulis menggunakan versi
1.3) dari http://sourceforge.net/project/show-
files.php?group_id=129083.
Lakukanlah langkah-langkah berikut un-
tuk melakukan instalasi:
® Ekstrak arsip driver dan masuk ke direk-
tori hasil ekstrak:
$ tar zxvf ZD1211LnxDrv_2_16_0_
@.tar.gz

$ cd ZD1211LnxDrv_2_16_0_0

MODPOST
make[3]: Leaving directory
“/usr/src/kernel-headers-2.6.8-
2-386°
mkdir -p /1ib/modules/2.6.8-2-
386/net
cp zd1211b.ko /1ib/
modules/2.6.8-2-386/net
depmod -a
make[2]: Leaving directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’
make[1]: Leaving directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’

make[1]: Leaving directory “/usr/
src/kernel-headers-2.6.8-2-386’
mkdir -p /1ib/modules/2.6.8-2-
386/net

cp zd1211b.ko /1ib/modules/2.6.8-
2-386/net

depmod -a 2.6.8-2-386

gcc -o apdbg apdbg.c

chmod +x apdbg

® [akukanlah kompilasi dengan memberi-
kan perintah berikut. Sebagai catatan,
perintah berikut juga akan langsung
melakukan instalasi sehingga harus di-
jalankan oleh root.
# make (warning tidak
ditampilkan pada output perintah
berikut):

® FEkstraklah firmware zd1211-firmware
1.3.tar.bz2 ke /lib/firmware/zd1211
# mkdir /1ib/firmware

# tar jxvf zd1211-
firmwarel.3.tar.bz?
zd1211-firmware/
zd1211-firmware/zd1211b_uphm

cp ./apdbg /sbin/apdbg

zd1211-firmware/zd1211_uphr

® Menjalankan modul kernel
Berikanlah perintah berikut untuk men-
jalankan modul kernel yang baru saja kita
install. Apabila semuanya berjalan lancar,
maka kita akan mendapatkan sebuah in-
terface dengan nama wlan0 secara default.
# modprobe zd1211b

make both

zd1211-firmware/README

make[1]: Entering directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’

zd1211-firmware/zd1211b_uph
zd1211-firmware/zd1211b_ub
zd1211-firmware/zd1211b_uphr

make clean

zd1211-firmware/zd1211_ub

make[2]: Entering directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’

zd1211-firmware/zd1211_ur
zd1211-firmware/zd1211_uph
zd1211-firmware/zd1211b_ur

ZD1211B - http://zd1211.ath.cx/
- r83

Based on www.zydas.com.tw driver
version 2.5.0.0

rm -rf .tmp_versions .*.cmd

zd1211-firmware/zd1211_uphm

*.ko *.mod.c *.mod.o *.o0 src/*.
0o src/.*.o.cmd menudbg apdbg
winevl_iface

# mv zd1211-firmware zd1211

usb 4-5: reset high speed USB
device using address 2
Release Ver = 4810

make[2]: Leaving directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’

EEPORM Ver = 4810

make ZD1211REV_B=0

PA type: @
Airoha AL223@S_RF
AllowedChannel = (0@107ff

make[2]: Entering directory
*/root/ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0_0’

Region: 48

/1ib/modules/2.6.8-2-386/build

usbcore: registered new driver
zd1211b registered new driver
zd1211b

Gunakanlah tool favorit Anda untuk

mengatur konektivitas.

Driver dari Vendor
Driver dari vendor disertakan di dalam CD

driver pada direktori Linux. Namun, kare-

# mv zd1211 /1ib/firmware/

® Menjalankan modul kernel

Berikanlah perintah berikut untuk men-
jalankan modul kernel yang baru saja
kita instal. Apabila semuanya berjalan
lancar, maka kita akan mendapatkan se-
buah interface dengan nama ethl (atau
eth0) secara default.

# modprobe zd1211b

make -C /1ib/modules/2.6.8-
2-386/build SUBDIRS=/root/
ZD1211BU/FROM_VENDOR/
ZD1211LnxDrv_2_16_0@_@ modules
make[3]: Entering directory
“/usr/src/kernel-headers-2.6.8-
2-386°

Building modules, stage 2.

Gunakanlah tool favorit Anda untuk

mengatur konektivitas.

USB wireless lan adapter kita pun bisa
digunakan. Sampai di sini dulu pembahasan
kita. Selamat mencoba! {)

Noprianto [noprianto@infolinux.co.id
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ntuk mengamati log sistem, dmesg bisa sangat membantu. Tulisan ini akan membahas

berbagai aspek pengamatan sistem dengan dmesg. Dengan memahami apa yang

terjadi, kita bisa mengambil langkah-langkah yang tepat untuk menyelesaikan

berbagai masalah.

Pada dasarnya, sistem Linux merupakan
sistem yang sangat nyaman untuk di-
gunakan, dalam artian user bisa memahami
banyak hal yang terjadi, dengan bantuan log
sistem. Apa yang sedang terjadi tidak akan
disembunyikan. Begitu sistem mengenali
dan menggunakan filesistem swap, kita juga
tahu. Begitu sistem mulai mengenali hard-
disk beserta partisinya, kita pun juga tahu.
Bahkan, ketika hardware baru ditancapkan,
kita bisa mengamati apa yang sedang ter-
jadi. Banyak masalah terkadang bisa disele-
saikan selama kita teliti mengamatilog, me-
mahami apa yang sedang terjadi dan pada
akhirnya, bisa mengambil tindakan yang
tepat. Jadi, kurang apa lagi?

Untuk mengamati log, kita bisa meng-
amati secara langsung, ataupun dengan
menggunakan berbagai tool yang ada. Salah
satu tool yang ada dan sangat berguna
adalah dmesg. Kita akan membahas bebe-
rapa aspek pengamatan sistem dengan tool
ini. Semua contoh di tulisan ini dibuat di
atas sistem Zenwalk Linux 4.2, namun se-
harusnya bisa diterapkan pada sistem lain-
nya tanpa masalah sama sekali.

Dmesg

Program dmesg merupakan anggota dari pa-

ket util-linux dan seharusnya bisa ditemu-

kan dalam hampir semua distribusi Linux

standar. Untuk mengamati log sistem,

dmesg bisa dijalankan oleh user biasa.
Berikut ini contoh 10 baris terakhir out-

put dmesg di sistem yang penulis gunakan.

$ dmesg [tail -nl@

ReiserFS: hda3: found reiserfs
format “3.6” with standard journal
ReiserFS: hda3: using ordered data
mode

ReiserFS: hda3: journal params:
device hda3, size 8192, journal
first block 18, max trans len
1024, max batch 900, max commit
age 30, max trans age 30
ReiserFS: hda3: checking
transaction log (hda3)

ReiserFS: hda3: Using r5 hash to
sort names

eth@: Tink down

[drm] Initialized drm 1.8.1
20051102

ACPI: PCI Interrupt
0000:00:02.0[A1 -> Link [LNKA] ->
GSI 11 (level, low) -> IRQ 11
[drm] Initialized 1915 1.5.0
20060119 on minor @

[drm] Initialized 1915 1.5.0
20060119 on minor 1

Setiap ada tindakan yang berhubungan
dengan sistem, log sistem akan bertambah
sehingga baris-baris terakhir akan senan-
tiasa berubah.

Apa yang kita lihat pada output terse-
but setidaknya telah dituliskan dalam
bahasa yang relatif bisa dipahami. Paling
tidak, cukup informatif. Sebagai contoh,
pada baris:
eth@: Tink down

Kita bisa melihat informasi bahwa link
pada ethO berada dalam status down.

Pada pembahasan-pembahasan berikut,
kita akan melihat beberapa contoh peng-
amatan sistem. Siapkan selalu terminal
emulator yang menyenangkan apabila Anda

berada di X.

Informasi-informasi seputar CPU

Di bagian ini, kita akan melihat beberapa
informasi seputar CPU yang ditemukan. Se-
bagai catatan, informasi mengenai CPU itu
sendiri bisa dibaca di /proc/cpuinfo.

Untuk mudahnya, kita akan meng-
gunakan bantuan grep untuk menyaring
secara case-insensitive hal-hal seputar CPU.
Berikut ini adalah contohnya:
$ dmesg | grep -i CPU
Initializing CPU#0
CPU: After generic identify,
caps: bfebfoff 00000000 00000000
p0000000 00004400 00000000
p0000000
CPU: After vendor identify,
caps: bfebfoff 00000000 00000000
p0000000 00004400 00000000
p0000000
CPU: Trace cache: 12K uops, L1 D
cache: 8K
CPU: L2 cache: 128K
CPU: Hyper-Threading is disabled
CPU: After all inits, caps:
bfebf9ff 00000000 00000000
p0000080 00004400 00000000
p0000009

74 04/2007

INFOLINUX

www.infolinux.web.id




TUTORIAL DMESG

CPUZ: Intel(R) Celeron(R) CPU
2.50GHz stepping 09

Brought up 1 CPUs

ACPI: CPUJ (power states: C1[C1]
c2[C2])

41 Initializing CPU#8

50 CPU: After generic
identify, caps: bfebf9ff (00000000
g00p0000 00000000 G0004400
00000000 00000000

Catatan penting

Harus kita perhatikan bahwa penyaringan
menggunakan program grep seperti ini
menjadikan kita tidak memiliki informasi
jeda atau informasi lain yang terdapat pada
log yang sesungguhnya. Misalnya, dari ha-
sil penyaringan yang terdiri dari 10 baris
tersebut, kita tidak bisa memastikan bahwa
baris kedua mengikuti baris pertama persis
di bawahnya, tanpa ada informasi lain di-
antara mereka. Adanya informasi lain anta-
ra baris satu dan baris lainnya bisa menjadi
sangat penting.

Kalau kita menyaring begitu saja se-
perti contoh ini, maka bisa-bisa informasi
penting antara baris tersaring terlewatkan.
Dan, untuk problem solving, hal ini bisa
mengganggu. Terkadang, suatu baris tidak
menuliskan keyword yang kita saring, na-
mun sebenarnya memiliki peran penting.

Sebagai solusinya, kita sebaiknya mem-
berikan nomor baris pada output dmesg se-
belum kita melakukan penyaringan. Paling
tidak, agar kita tahu bahwa mungkin terdapat
baris-baris sebelumnya atau setelahnya yang
mungkin relevan ketika kita mencoba untuk
menyelesaikan suatu permasalahan. Untuk
memberikan nomor baris, kita bisa menggu-
nakan program nl, yang menjadi bagian dari
paket coreutils (terdapat di hampir semua
distribusi Linux).

Contoh pemberian nomor baris:
$ dmesg | nl | head -n4

1 Linux version 2.6.18.6
(root@hal) (gcc version 3.4.6) #1
SMP PREEMPT Wed Dec 20 16:47:04
CET 2006

2 BIOS-provided physical RAM
map:

3 BIO0S-e828:
0000000000000000 -
p000eeA00EEAIT8AA (usable)

4 BIOS-e820:
P00000000009f800 -

51 CPU: After vendor
identify, caps: bfebf9ff 00000000
g00p0000 00000000 G0004400
00000000 00000000

52 CPU: Trace cache: 12K
uops, L1 D cache: 8K

53 CPU: L2 cache: 128K

54 CPU: Hyper-Threading is
disabled

55 CPU: After all inits,
caps: bfebf9ff 00000000 00000000
g0000080 00004400 B000B0000
00000000

62 CPUZ: Intel(R) Celeron(R)
CPU 2.50GHz stepping @9

@x1818-@x181f, BIOS settings: hdc:
DMA, hdd:pio

172 Probing IDE interface
ided...

174 idef at Ox1f@-@x1f7,0x3f6
on irq 14

175 Probing IDE interface
idel...

177 idel at @Ox178-0x177,0x376
on irq 15

Dari output tersebut, bisa kita lihat
bahwa sistem mendeteksi adanya dua IDE,
ide0 dan idel, yang masing-masing berada
pada IRQ 14 dan 15. Terdapat informasi
lain yang lebih teknikal, yang akan sangat
berguna bagi developer sistem.

Contoh penyaringan dengan keyword
hda:
$ dmesg | nl | grep -i hda

65 Brought up 1 CPUs
336 ACPI: CPUJ (power states:
C1[C1] c2[C2])

35 Kernel command line:
root=/dev/hdal resume2=swap:/dev/
hda5 splash=silent vga=773

Dari informasi tersebut, setidaknya kita
bisa memahami informasi seputar CPU itu
sendiri (seperti kecepatan, ukuran cache
level 2 dan status hyperthreading), beserta
sistem telah mengenali 1 CPU dan meng-
aktifkannya (Brought up 1 CPUs). Kita bisa
melihat bahwa subsistem ACPI juga telah
bekerja dengan CPU pertama (ACPI: CPUO
(power states: C1[C1] C2[C2])).

Storage device

Dengan menggunakan bantuan program
dmesg, kita juga bisa melihat informasi
seputar storage device seperti harddisk,
CDROM, removeable storage device seperti
USB flash disk dan lain sebagainya.

Harddisk (IDE)
Untuk mengamati apa yang terjadi dengan
harddisk IDE, kita bisa menyaring berdasar-
kan keyword hdX, di mana X adalah a, b, ¢
dan d. Selain itu, kita juga bisa menyaring
berdasarkan keyword ideX di mana X adalah
0,1,2dan 3.

Contoh penyaringan dengan keyword
ideX:

170 ide@: BM-DMA at
@x1810-0x1817, BIOS settings: hda:
DMA, hdb:pio

173 hda: SAMSUNG HM1@@JC, ATA
DISK drive

178 hda: max request size:
512KiB

179 hda: 195371568 sectors

(100030 MB) w/8192KiB Cache,
CHS=16383/255/63, UDMA(108)

184 hda: cache flushes
supported
181 hda: hdal hda2 hda3 hda4

< hda5 hda6 hda7 >

250  XFS mounting filesystem
hdal

252 Ending clean XFS mount for
filesystem: hdal

329 Adding 979924k swap on
/dev/hdab. Priority:-1 extents:1
across: 979924k

341 ReiserFS: hda3: found
reiserfs format “3.6” with
standard journal

342 ReiserFS: hda3: using
ordered data mode

343 ReiserFS: hda3: journal

00000000000ad008 (reserved) $ dmesg | n1 | grep -i ide[#-3] params: device hda3, size 8192,
170 ide@: BM-DMA at journal first block 18, max trans
Contoh penyaringan dengan keyword | @x1818-0x1817, BIOS settings: hda: Ten 1824, max batch 900, max
CPU seperti dibahas sebelumnya: DMA, hdb:pio commit age 3@, max trans age 30
$ dmesg | n1 | grep -i CPU 171 idel: BM-DMA at 344 ReiserFS: hda3: checking
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&=

transaction log (hda3)

hash to sort names

® Penambahan swap:

Terminal

File Edit View Terminal Go Help

ethO:

link down

Status link ethernet.

345 ReiserFS: hda3: Using rb

Beberapa informasi yang bisa didapatkan:
Merk harddisk dan properti lainnya:

173 hda: SAMSUNG HM1@@JC,
ATA DISK drive

178 hda: max request size:
512KiB

179 hda: 195371568 sectors
(100030 MB) w/8192KiB Cache,
CHS=16383/255/63, UDMA(189)

180 hda: cache flushes
supported
Tabel partisi:

181  hda: hdal hda2 hda3

hda4 < hda5 hda6 hda7 >

Informasi mount berbagai partisi:

250  XFS mounting filesystem
hdal

252 Ending clean XFS mount
for filesystem: hdal

341 ReiserFS: hda3: found
reiserfs format “3.6” with
standard journal

342 ReiserFS: hda3: using
ordered data mode

329 Adding 979924k swap on /
dev/hdab5. Priority:-1 extents:1

across: 979924k

CD-ROM
Untuk mengamati informasi CDROM, kita
bisa menyaring berdasarkan keyword cd-
rom. Contoh:
$ dmesg | n1 | grep -i cd-rom

182 hdc: ATAPI 24X CD-ROM
drive, 128kB Cache, UDMA(33)

183 Uniform CD-ROM driver
Revision: 3.20

Dari informasi tersebut, setidaknya kita
bisa mengetahui cache cdrom (dalam hal ini
128kB), kecepatan baca (24X) dan meru-
pakan device UDMA 33.

Removeable storage device (USB Flash Disk)
Tancapkanlah USB flash disk dan gunakan
keyword sdX untuk penyaringan, di mana X
adalah a,b,c, dan seterusnya.

Contoh penyaringan dengan keyword
sda:
$ dmesg | nl | grep -i sda

361 SCSI device sda: 3901952
512-byte hdwr sectors (1998 MB)

362 sda: Write Protect is off

363 sda: Mode Sense: 03 00 00
00

364 sda: assuming drive cache:

write through
365 SCSI device sda: 3901952
512-byte hdwr sectors (1998 MB)
366 sda: Write Protect is off
367 g3 00 00

sda: Mode Sense:

20

368 sda: assuming drive cache:
write through

369 sda: sdal

370 sd 0:0:0:0: Attached scsi

removable disk sda

Berdasarkan hasil penyaringan tersebut,
kita bisa mendapatkan:
® Ukuran USB flash Disk dan properti lain-
nya.
361 SCSI device sda: 3901952
512-byte hdwr sectors (1998 MB)

362 sda: Write Protect is
of f

363 sda: Mode Sense: @3 00
00 00

364 sda: assuming drive

cache: write through

Perangkat jaringan
Untuk menyaring informasi tentang pe-
rangkat jaringan, kita dapat menggunakan
keyword nama interface seperti ethX atau
wlanX (atau lainnya sesuai perangkat dan
kernel; rujuklah ke manual device ataupun
dokumentasi kernel), di mana X adalah 0, 1,
2, dan seterusnya.

Contoh keyword berupa ethO:
$ dmesg | nl | grep -i eth@

324 eth@: RealTek RTL8139 at
PxefB870000, 00:0a:e4:47:3e:11, IRQ
11

325 eth@: Identified 8139
chip type ‘RTL-8181’
346 eth@: Tink down

Dari hasil penyaringan tersebut, bisa
kita dapatkan:
® Merek ethernet card pertama dan infor-
masi lain seperti MAC address:

324 eth@: RealTek RTL8139 at
Oxef870000, 00:0a:ed:47:3e:11,
IRQ 11

325 eth@: Identified 8139

chip type ‘RTL-8181’

® Status link (up/down):
346 eth@: 1ink down

Tips keyword penyaringan

Dalam melakukan penyaringan, kita akan
membutuhkan keyword. Dan, kita yang ha-
rus menentukan keyword tersebut. Dengan
demikian, kita perlu mengetahui beberapa
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aturan yang digunakan oleh kernel. Sebagai

contoh:

® Nama device harddisk IDE, yaitu hdX, di
mana X adalah a,b,c,d, pada umumnya.

® Nama device harddisk SCSI, yaitu sdX, di
mana X adalah a,b,c, dan seterusnya.

® Nama interface jaringan, seperti ethX,
wlanX, di mana X adalah 0,1,2, dan se-
terusnya.

® Nama subsistem yang dikenal kernel
seperti IDE, SCSI, USB, dan PCL.

Beberapa tip:

® Apabila kita ragu dengan nama device,
misalnya kita tidak yakin apakah sdb
atau sdc, maka awalnya, kita bisa mem-
perluas pencarian dengan keyword sd
dan bukannya sdb atau sdc saja. Bah-
kan, kita bisa mencari berdasarkan sub-
sistemnya, misal USB.

® Apabila kita ingin memeriksa suatu per-
angkat dan lebih kurang kita mengetahui
nama modul kernelnya (tidak harus spe-
sifik device, bisa saja modul dasar), misal
usb-storage, maka keyword tersebut bisa
diberikan.

® Gunakan keyword case-insensitive.

® Penggunaan regular expression dengan
bantuan program grep bisa pula diper-
gunakan.

® Untuk kondisi terakhir, kita bisa mem-
pergunakan bantuan program tail.

Menyelesaikan berbagai masalah

Dengan mengamati log sistem, tak jarang

kita bisa menyelesaikan berbagai masalah.

Sebagai contoh:

® Apabila hardware yang Anda gunakan,
yang telah dikenal oleh Linux (infor-
masi ini Anda dapatkan dari milis/
website terpercaya, sebagai contoh) ti-
dak dapat bekerja (sementara Anda ya-
kin modul kernel telah disertakan oleh
distribusi/telah Anda kompilasi sendiri
tanpa masalah), maka cobalah pelajari
log sistem ketika hardware tersebut
ditancapkan. Tak jarang wireless LAN
adapter yang membutuhkan firmware
tidak dapat bekerja karena firmware-
nya tidak disertakan oleh distribusi,
karena masalah legal. Umumnya, ter-
dapat pesan (tidak semua hardware)
tentang apa yang sedang dilakukan
ketikahardware ditancapkan/diinisiali-

sasi.

® Apabila Anda mengelola user di mana
user Anda membutuhkan aplikasi
semacam ‘status box’ yang menampil-
kan informasi perangkat tertentu,
seperti ethernet O link up, ethernet 0
link down dan sebagainya, Anda bisa
tetap memanfaatkan dmesg dan me-
nyaring informasi yang berhubungan
dengan perangkat yang Anda amati.
Kita akan membangun contoh ap-
likasinya setelah ini.

Informasi status link ethernet

Kita akan membangun aplikasi kecil yang
akan menampilkan status link ethernet:
up (dan informasi tambahan lain) ataupun
down.

Aplikasi akan kita bangun dengan shell
script. User interface akan kita bangun de-
ngan bantuan dialog:

Source code eth_Tink_stat.sh

#1/bin/sh

while [ 1]
do

LINK_STAT=""dmesg | grep
-i ‘eth[@-9]: 1ink’| tail -nl1'”
dialog --infobox “$LINK_

STAT” 10 40
sleep 2

done

Berikanlah hak akses executable pada
script tersebut dengan perintah:
$ chmod +x eth_Tink_stat.sh

Untuk menjalankan aplikasi:
$ ./eth_link_stat.sh
Ketika aplikasi tersebut dijalankan, se-

buah infobox berisi informasi status link
ethernet akan ditampilkan.
Penjelasan source code:
® Aplikasi akan mengulang terus menerus
® Di dalam perulangan:
® Kita akan mendapatkan status link
eth, kemudian mengambil informasi
terakhir.
® Informasi kemudian ditampilkan.
® Perulangan ditunda selama 2 detik.

Sebagai sistem yang terbuka, Linux
memang sangat menarik. Selama kita ra-
jin mempelajari dan mengutak-atik, maka
Linux pun akan semakin ramah terhadap
kita. Sampai di sini dulu pembahasan kita.
Selamat mencoba dan mengembangkan! )

Noprianto [noprianto@infolinux.co.id
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